
Example - Add Files to Project

Let's say that we have navigated to a directory called C:\BMPEDIT and there is a subdirectory of C:\
BMPEDIT called C:\BMPEDIT\SAMPLES.    If we now choose All files in directory tree and click OK, all of 
the files in C:\BMPEDIT and C:\BMPEDIT\SAMPLES will be added to the project.



Add Files to Project...
Opens the Add Files to Project screen which allows you to navigate through your disk drives and 
directories to find the files that you want to add to your Setup Factory project.    To add files to your 
project, simply highlight the files that you want, select an Add option, and click the OK button.    To 
highlight a file, click the filename.    To highlight more than one file, hold down the Ctrl key while clicking 
the filename.    To select a consecutive group of files, click on the first filename, then hold down the Shift 
key and click on the last file in the group.

The Add options at the bottom of the dialog are:

Selected file(s)
Only the highlighted file(s) will be added to the project when the OK button is clicked.

All files in directory
If selected, all of the files in the currently open directory will be added to the project when the OK button is
clicked.    In other words, all of the files listed in the Filename box will be added to the Project whether 
they are highlighted or not.

All files in directory tree
If selected, all of the files in the currently open directory and all of the files found in directories below it will 
be added to the project.    In other words, all of the files listed in the Filename box will be added to the 
project as well as all of the files found in subdirectories of the current directory.

Example - Adding an entire directory tree to a Project



The file that we are installing will always overwrite an existing file with the same name.



The user will be asked whether or not the existing file should be overwritten.



If the file we want to install is older that the existing file, the user will be asked whether or not the existing 
file should be overwritten.



Bat/Sys File Command
The Bat/Sys File Command screen can be used to create or modify one text file change at a time.

Full path and filename
The full path and filename of the file that you want to modify.    You can use an absolute path such as "C:\
AUTOEXEC.BAT" or a path using Inline Variables such as "%AppDir%\MYDATA.BKD".

Action to perform
The action to perform on the file.    Here is a list of available actions that can be performed on a text file.

Add line to beginning of file - Adds the text specified in Add / Append this text to the beginning of 
the file.    If the file does not exist, it will be created.

Add line to end of file - Adds the text specified in Add / Append this text    to    the end of the file.    
If the file does not exist, it will be created.

Append text to search line - Appends the text specified in Add / Append this text    to    the end of 
the line that contains the text specified in Search for the line containing this text.    If the search line is not 
found, no changes will be made to the file.

Delete search line - Deletes the line that contains the text specified in Search for the line 
containing this text.    If the line is not found, no changes will be made to the file.

Insert line after search line - Adds the text specified in Add / Append this text    after the line that 
contains the text specified in Search for the line containing this text.    If the search line is not found, the 
line will be added to the end of the file.

Insert line before search line - Adds the text specified in Add / Append this text    before the line 
that contains the text specified in Search for the line containing this text.    If the search line is not found, 
the line will be added to the end of the file.

Make backup of the file - The file specified in Full path and filename will be backed up.    The 
backed up file will have the extension ".bak".

Search for line containing this text
The text that you want to search for in the file.    This is only applicable if you have specified an action in 
Action to perform that searches for a line such as Delete search line.

Add/Append this text
The text that will be added to the file.    If you have chosen Append text to search line in Action to perform, 
this text will be appended to the end of the search line.    Otherwise, this text will be on a line by itself in 
the specified position.

Example 1 - Adding a line to the end of the Autoexec.bat file
Example 2 - Adding a directory to the Autoexec.bat's PATH statement
Example 3 - Making a backup of a file



Bat/Sys File Editor...
Choosing Bat/Sys File Editor from the Project menu will open the Bat/Sys File Editor screen.    The 
Bat/Sys File Editor can be used to make modifications to the AUTOEXEC.BAT, CONFIG.SYS, or any 
other ASCII text file.

Note:    It is generally not advisable or necessary to modify the AUTOEXEC.BAT or CONFIG.SYS files 
when using a Windows program.    Be sure that you know what you are doing if you modify one of the 
user's system files.    It is also a good idea to tell the user if you are changing a system file.    It is also a 
good practice to backup the file before modifying it (see Make backup of the file).

The Bat/Sys File Editor screen consists primarily of a large list box.    This box contains a list of all file 
modifications that will be made during the installation.    Each modification is on its own line, therefore 
each line in this list represents one Bat/Sys File Command.    The commands on this screen will be 
executed in top - down order.

You can create and order your Bat/Sys File Commands using the buttons on the right side of the screen:

Add
Opens the Bat/Sys File Command screen which allows you to create a Bat/Sys File Command.    The 
command that is created will be added to the end of the list.

Insert
Opens the Bat/Sys File Command screen which allows you to create a Bat/Sys File Command.    This 
new command will be inserted directly above the command that was highlighted before clicking the Insert 
button.

Edit
Opens the Bat/Sys File Command screen and allows you to edit the currently selected Bat/Sys File 
Command.

Remove
Removes the currently selected Bat/Sys File Command from the list.

Up
Moves the currently selected Bat/Sys File Command up one position in the list.

Down
Moves the currently selected Bat/Sys File Command one position down in the list.



Build Menu
The Build menu contains options that relate directly to the creation of your setup program    and the 
resulting disk set.

Settings...
Create Master Disk Set



CD-ROM Considerations
If you are preparing to create a CD-ROM based installation, you will want to decide which files Setup 
Factory will be installing to the user's hard drive and what files are to be accessed from the CD-ROM 
during the use of your software.    If you wish to have Setup Factory create icons that point to files left on 
the CD-ROM, you will have to know ahead of time where these files will be located on the CD.    To read 
more about how to create icons for files on the CD-ROM, see Shortcut Editor.
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Closing Message...
This is normally the last screen your users will see.    If you choose to display this screen, it will be 
displayed after the installation is complete.    The files have already been installed, system changes made,
and shortcuts created.    Here you can put any message that is appropriate for your software, such as a 
thank you, a final greeting, instructions about starting up you software or anything else that comes to 
mind.    See General Screen Design Layout for more details about the fields on this screen.



Collect Information
There are ten Collect Information Screens that you can make use of.    These screens are used to gather 
information from the user during installation.    The user's responses are assigned to the Inline Variables 
%Custom1% - %Custom10%.    These Inline Variables can be used in a number of places, such as the INI
File Editor and the Bat/Sys File Editor.    Using these editors you can write the values out to a file that can 
be retrieved by your software.

All ten screens use the same format:

Message Box
The question or prompt to display to the user.

Default Text
The text that will be displayed as a default response during the installation.    For example, if you were an 
Internet Service Provider, you might be asking for the user's email address and want to provide a default 
such as YourName@OurDomain.com.    Leave this field blank if you do not want any default text.

Maximum length of response
The maximum number of characters you want to allow as a response.    Enter a 0 to specify that there is 
no limit to the number of characters.

See General Screen Design Layout for more details about the fields on this screen.



Completion - Terminate
Exit Setup
If checked, the installation will simply shut down after it has finished.    This is the option that most people 
will use and unless you have specific requirements, there is little reason to change this.

Restart Windows
If checked, the installation will attempt to shut down and restart Windows.    In some cases this may not 
always be possible (other software refuses to end, invalid security permission, etc.), in which case the 
user will be notified that Windows could not be restarted automatically.

Restart System
If checked, the installation will attempt to shut down and restart their computer.    In some cases this may 
not always be possible (other software refuses to end, invalid security permission, etc.), in which case the
user will be notified that the system could not be restarted automatically.



Termination...
The Termination dialog has the following tabs:

Terminate



Conditions
This is where you can specify "why" a command is executed.    If the conditions are not met, then the 
command will be ignored.

Operating System
Execute this command if the user is installing on a particular operating system.    Choose from:

Any - This command should be executed regardless of the operating system.
Windows 3.1
Windows 95
Windows NT 3
Windows NT 4

Package
Only execute this command if the following package is installed.    The default here is the special package 
called "None".    Since the package "None" is always installed, you can be sure that your command will 
always be executed.

You would normally only use this Package condition if you have enabled the Selective Install feature.    
With a selective install, you may need to control the execution of the command based on which packages 
are being installed by the user.    For example, if your Minimum install does not include a package called 
"Graphics", you may not need to execute the file "Graphic.exe".    Use this condition to control that 
behavior.



Setup Factory 4.0 - Help Contents
Welcome to the Setup Factory 4.0 help file!    If you are just learning how to use Setup Factory, it is 
suggested that you move through the help topics in the order that they appear below.

Features
Preparing Your Software for Distribution
Tutorial
The Main Screen
Menu Commands
Inline Variables
Tips & Tricks
Getting Technical Support
Licensing & Ordering Information
Disclaimer



Create Master Disk Set
Selecting Create Master Disk Set from the Build menu will start the process of building your installation.    
You will want to double check your project before choosing this command.    Make sure you have chosen 
the appropriate Setup Module and Language Module in Build | Settings.    Are all of your files ready?    
Have you displayed the Screens that you want?

The first thing that Setup Factory will do when you select this command is to verify that there are no 
obvious errors in your project, such as files that do not exist and settings that do not make sense.    If 
everything seems to be all right, Setup Factory will compress your files, optimize your Wallpaper and 
Wizard screen images, create a custom Setup program, and finally combine everything into a single setup
archive.    Once this setup archive has been created, you will be presented with the Setup Factory Disk 
Builder screen.    The Disk Builder is where you will actually output your setup to disk.



Determining Where to Install Files on the User's 
System
Once you have your software prepared on your machine, you need to determine exactly where each file 
needs to go on the user's machine.    Although Setup Factory does a lot of this work for you by 
maintaining directory structures, etc., there are still some files that may need to be directed to different 
locations on the user's system.    There are four broad categories of files and file locations that your 
application may require.    They are program files, initialization files, operating system components and 
shared application resources.    Here is a brief description of each of these categories and the suggested 
destination directories for each type.

Program Files
These are the files that are essential to your application and are only useful in the context of your 
application.    Examples of program files may be executable files (.EXE), Help files (.HLP) and other text 
and data files that your application requires.    These files should be installed to the directory that the user 
chooses during the installation process (if they are given that choice).    Throughout this manual and in the
Setup Factory program this directory is referred to as the application directory and is represented by the 
Inline Variable %AppDir%.

Even though you may be installing program files to subdirectories of the application directory, these 
locations are still considered to be the application directory since they all branch from the one common 
directory.

Initialization Files
These files are used to control startup options for the user.    Information can also be read from and written
to them during the operation of your application.    Traditionally, initialization files (or, INI files) have been 
installed to the WINDOWS directory (%WinDir%).    This is definitely not necessary or beneficial in all 
cases.    In fact, unless your program shares the INI files with other programs, it is best to install them to 
the application directory along with the program files.

Note:    INI files are generally used in Windows 3.1 applications.    Under Windows 95 / NT the Registry is 
used for many of the initialization tasks.

Operating System Components
These files are usually included with Windows but you may want to distribute the newest versions of 
certain files or you may have custom files of your own.    These files are generally DLL files.    Operating 
system components are traditionally installed to the WINDOWS\SYSTEM directory (%SysDir%).    If your 
application does not need to share these files with other applications, it is best to install them to your 
application directory instead.

Shared Application Resources
These are resource files that may be shared by more than one application such as OCX, VBX and DLL 
files.    OCX, VBX and DLL files are generally installed to the WINDOWS\SYSTEM directory.    OLE 
Automation servers are generally installed to the WINDOWS\OLESVR directory in Windows 3.1 and 
Windows NT and to the    PROGRAM FILES\COMMON FILES\OLESVR directory in Windows 95.



Determining the Files You Need To Distribute
The first step in preparing your Setup program is to determine exactly what files your software requires for
proper operation.    There are two basic types of files that you want to distribute: your program files and 
the dependency files.    Program files generally include your executables, data files, help files or whatever 
your main software type happens to be.

The dependency files are support files that your program needs for proper operation.    These may include
INI files, DLLs, VBX files, OCX files or any other support file type.    Support files are sometimes installed 
to locations other than the location of the program files such as the Windows or System directories.

Some of the files that you need to distribute are obvious, such as executable and help files, while some 
are less apparent such as DLLs and VBXs, etc.    Many of today's development tools such as Visual Basic
require that you distribute support files along with your application.    Please consult your development 
tool's documentation to determine what files you need to distribute in addition to your program.



Disclaimer
Warranty: Disclaimer
THIS SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.    THE ENTIRE RISK AS TO THE 
QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU.    SHOULD THE SOFTWARE 
PROVE DEFECTIVE, YOU (NOT INDIGO ROSE SOFTWARE DESIGN CORPORATION) ASSUME THE 
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

INDIGO ROSE SOFTWARE DESIGN CORPORATION DOES NOT WARRANT THAT THE FUNCTIONS 
CONTAINED IN THIS SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION 
OF THIS SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE.

IN NO EVENT WILL INDIGO ROSE SOFTWARE DESIGN CORPORATION BE LIABLE TO YOU FOR 
ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SALES, INJURY TO PERSON OR 
PROPERTY OR ANY OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OR INABILITY TO USE THIS SOFTWARE EVEN IF INDIGO ROSE SOFTWARE DESIGN 
CORPORATION OR ITS AUTHORIZED REPRESENTATIVE(S) HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.    IN NO EVENT 
SHALL INDIGO ROSE SOFTWARE DESIGN CORPORATION'S LIABILITY EXCEED AMOUNTS PAID 
TO LICENSOR BY LICENSEE UNDER THE TERMS OF THE LICENSE AGREEMENT.

BY USING THIS SOFTWARE, YOU ACKNOWLEDGES THAT YOU HAVE READ THIS DISCLAIMER, 
UNDERSTAND IT, AND AGREE TO BE BOUND BY IT.



Disk Builder Screen
The Setup Factory Disk Builder is used to output the setup archive that was created during the last step of
the compression phase.    Here is where you can choose the filename for your setup program, such as 
Setup.exe or Install.exe.    

Information Section

The Information Section lets you know how many disks will be required to output your disk set.    Unless 
you plan on outputting your setup to your hard drive, make sure you have this number of newly formatted,
error free disks ready.    One of the most common problems we have found is related to using bad disks.    
You can save yourself a few headaches by verifying that the disks you use are of high quality and free of 
errors.    Even if your disks say that they are "pre-formatted", they may not be completely free of errors.    
Format them again to be sure.    If you do not know how to format disks, then please consult your 
operating system instruction manual.

One other occasional problem is dirty or misaligned disk drives.    If your drive heads are dirty or are not 
aligned properly, you may get spurious errors and find that the disk sets you create work fine on your 
computer, but report errors on the computer down the hall.    If this is the case, you will need to have your 
drive cleaned and aligned by a qualified computer repair technician.

General Section

Setup Filename
The name of the Setup file that will be created by Setup Factory.    You can choose from Setup.exe, 
Install.exe or type in another name.    It is recommended that you use Setup.exe in order to conform to 
industry guidelines.

Output Directory
The drive and path to output your setup to.    If you are building to floppies, you will enter either A: or B: 
here.    If you want to build to a directory on your hard drive, you would enter the path of an existing 
directory here.    For example, you could enter a path such as "C:\OUTPUT".    Note that the directory 
must exist on your hard drive before you click on the Output button - Setup Factory will not create the 
directory for you.

Advanced Section

Segment Size
This field is used to control the size of the setup pieces that will be created.    Most people will leave this at
the default setting of Largest Possible.    When Largest Possible is chosen, Setup Factory will 
automatically determine the amount of free space available on the chosen output disk and create a setup 
piece that fits in the available space.    The first setup piece is given the name you chose in Setup 
Filename above (e.g. Setup.exe).    If there is not enough space on the disk to fit the entire setup, you will 
be prompted for another disk.    The next setup piece will have its filename modified to reflect the piece 
number, such as Setup.2, Setup.3 etc.

If you are outputting to your hard drive, you may find some of the other Segment Size setting useful.    For 
example, if you choose Largest Possible when outputting to your hard drive, you will end up with a single 
Setup.exe file.    This is great if you want to distribute your installation over the Internet or other online 
services, however it may not be so great if your Setup.exe ends up being 5MB in size and you want other 
people to be able to store your setup on floppy disks.    In that case, you can set the Segment Size to 
something like 1.44MB 3½" and have the Disk Builder output pieces that can later be copied to a 1.44MB 
disk. 



You have the following Segment Size options:

Largest Possible - Automatically determine the amount of free space available on the chosen 
output disk and create setup pieces that fit in the available space.    For example, if you are building to 
1.44M floppies, Setup Factory will fill each diskette to capacity as it builds the disk set.    If you are building
to the hard drive, a single Setup.exe file will be created.

360K 5¼", 720K 3½, 1.2MB 5¼", 1.44MB 3½", 2.88MB 3½" - Standard diskette sizes.    This 
option is normally used if you are building to your hard drive and want to copy the setup pieces over to 
diskettes later.

Any other number - The segment size in bytes.    Use this option when you need to create a 
custom segment size.

Once you are satisfied with the options you have chosen on the Disk Builder screen, click on the Output 
button to start the output process.    Follow the prompts on your screen and insert newly formatted disks 
when you are asked for them.    When the output process is complete, you will be notified and then 
returned to the Disk Builder.    You can choose to output your disk set again, perhaps using different 
output paths and segment sizes, or you can click on Cancel to return to Setup Factory's Main Screen.

Now that you have created your setup, be sure to test it!    It is a bit of a pain to find out from your 
customer that you forgot to include a file or some other easily avoidable problem.



Edit Message
Current text
The text that we are currently editing in its original form.

New text
The new text that will replace the original text specified in Current text above.



Example - Bat/Sys File Command

Here are the values for the fields on the Bat/Sys File Command screen that may be used to add the line 
"C:\Dos\Share.exe" to the end of the AUTOEXEC.BAT file:

Full path and filename - C:\AUTOEXEC.BAT
Action to perform - Add line to end of file
Search for the line containing this text - Not used for this action
Add/Append this text - C:\Dos\Share.exe



Example - Bat/Sys File Command

Here are the values for the fields on the Bat/Sys File Command screen that may be used to add the 
directory that the user chooses to install to during the install to the AUTOEXEC.BAT's PATH statement:

Full path and filename - C:\AUTOEXEC.BAT
Action to perform - Append text to search line
Search for the line containing this text - PATH
Add/Append this text - ;%AppDir%



Example - Bat/Sys File Command

Here are the values for the fields on the Bat/Sys File Command screen that may be used back up a file 
called MYINI.INI which will be installed to a subdirectory of the application directory called Data:

Full path and filename - %AppDir%\Data\MYINI.INI
Action to perform - Make backup of the file
Search for the line containing this text - Not used for this action
Add/Append this text - Not used for this action



Example - Execute Program

Suppose that you want to execute a program called EXECUTE.EXE which resides uncompressed on the 
last disk of your disk set in a subdirectory called RUN at the end of the installation.    You would enter the 
following values:

Ask for disk before trying to execute program - Not checked
Disk Title - Blank
Program to execute - %SrcDir%\RUN\EXECUTE.EXE

Note that the Ask for disk before trying to execute program feature is not used here.    We can assume 
that the user will still have the last disk in the drive at the time that the program is executed.



Example - Execute Program

Another case may be that you want to execute a program called MYPROG.EXE which has been installed 
to the user's hard drive by Setup Factory.    You would enter the following values:

Ask for disk before trying to execute program - Not checked
Disk Title - Blank
Program to execute - %AppDir%\MYPROG.EXE



Example - Execute Program

As one final example, let's say that you want to run the setup program of a third party application called 
MPEG Viewer which resides on it's own 2 disk disk set.    The name of the file that we want to run is 
INSTALL.EXE and resides on disk 1 of the MPEG Viewer disk set.    You would enter the following values:

Ask for disk before trying to execute program - Checked
Disk Title - MPEG Viewer Disk 1
Program to execute - %SrcDrv%\INSTALL.EXE



Example - INI File Command

Here are the values for the fields on the INI File Command screen that you would use to associate files 
with the .bmp extension to your application called BMPEDIT.EXE which was installed into the application 
directory:

Filename - %WinDir%\WIN.INI
Action - Add or Replace
Section - Extensions
Key - bmp
Value - %AppDir%\BMPEDIT.EXE ^.bmp



Example - INI File Command

Here are the values for the fields on the INI File Command screen that you would use to change the 
user's cursor blink rate to 530 as defined in their WIN.INI file:

Filename - %WinDir%\WIN.INI
Action - Add or Replace
Section - Windows
Key - CursorBlinkRate
Value - 530



Example - Install file to this directory

To install the file to a subdirectory of %AppDir% called DATA, enter:

%AppDir%\DATA



Example - Install to this directory

To install the file to the user's Windows directory, enter:

%WinDir%



Example - Registry Command

Here are the values for the fields on the Registry Command screen that you would use to add 
Bmpedit.exe's PATH to the 32-bit registry:

Action - Set Value
Main - HKEY_LOCAL_MACHINE
Sub Key - SOFTWARE\Microsoft\Windows\CurrentVersion\AppPaths\Bmpedit.exe
Type - REG_SZ
Name - Path
Value - %AppDir%\Bmpedit.exe



Example - Registry Command

Here are the values for the fields on the Registry Command screen for the two commands that you would 
use to associate the *.bmp file extension with the Bmpedit.exe program that we have installed in the 16-
bit or 32-bit registry:

Command 1:
Action - Set Value
Main - HKEY_CLASSES_ROOT
Sub Key - .BMP
Type - REG_SZ
Name - <No Name>
Value - Bmpeditor

Command 2:
Action - Set Value
Main - HKEY_CLASSES_ROOT
Sub Key - Bmpeditor\shell\open\command
Type - REG_SZ
Name - <No Name>
Value - %AppDir%\Bmpedit.exe %1



Example - Shortcut Command

To create a folder called "My Program Folder" in the Start menu | Programs (Windows 95, NT 4.0) or the 
Program Manager (Windows 3.1, NT 3.51), the Shortcut Command values would be:

Command - Create folder
Folder - My Program Folder



Example - Shortcut Command

To create a shortcut for a file which resides on the source drive (often this command is used to create a 
shortcut which points to a file on a CD-ROM) called HELPFILE.HLP in a sub-directory called DOCS in the
folder that the user chose to install to, you would use the following Shortcut Command values:

Command - Add shortcut to folder
Folder - %AppFolder%
Description - Help File
Points to - %SrcDrive%\DOCS\HELPFILE.HLP
Arguments - None
Working dir - %SrcDrive%\DOCS
Icon path - %SrcDrive%\DOCS\HELPFILE.HLP
Icon index - 0



Example - Shortcut Command

To delete the folder called "Old Group" as well as any shortcuts in that group, the Shortcut Command 
values are:

Command - Remove Folder
Folder - Old Group



Example - Shortcut Command

To delete the shortcut called "BMP Edit Old" from the folder called "BMP Editor", the Shortcut Command 
values are:

Command - Remove shortcut from folder
Folder - BMP Editor
Description - BMP Edit Old



Example - Shortcut Editor

To create a shortcut called "BMP Editor" in a folder called "Shortcut to BMP Editor" on the Windows 95 / 
NT 4.0 desktop that points to the BMPEDIT.EXE file in the application directory, the Shortcut Command 
values are:

Command - Add shortcut to folder
Folder - %Desktop%\Shortcut to BMP Editor
Description - BMP Editor
Points to - %AppDir%\Bmpedit.exe
Arguments - None
Working dir - %AppDir%
Icon path - %AppDir%\Bmpedit.exe
Icon index - 0



Execute Page
Full path and filename of program
The fully qualified path and filename of the program you want to execute.    Although this can be an 
absolute path (e.g. C:\MyDir\MyFile.exe), you will most likely want to use Inline Variables such as 
%AppDir%, %AppDrv%, %SrcDir% and %SrcDrv% to specify the path (e.g. %AppDir%\MyFile.exe).    The
most common Inline Variable are available from the drop down list.

Arguments to be passed to the program
Type in any command line arguments, parameters, switches etc. that need to be passed to the program.   
Inline Variables can be used.

Wait for program to end before continuing
If checked, the setup will wait until after the program has finished running before it continues.    If not 
checked, the setup will simply start the other program and continue running.



Execute Program
The Execute Program sheet is used to control how, why and when a program is run by the setup.    This 
sheet is divided into three pages as follows.

Execute
Timing
Conditions



Execute
Choosing Execute... from the Project menu will open the Execute Commands editor.

This screen contains a list of all the programs that will be executed (run) by the setup program.    Each 
program is on its own line.    The programs will be executed in top-down order using the conditions and 
timing you set for each program.    You create and order your commands using the buttons on the right 
side of the screen:

Add
Add a new command to the end of the list.    This button opens up the Execute Program screen.

Insert
Insert a new command directly above the highlighted command.    This button opens up the Execute 
Program screen.

Edit
Edit the currently selected command.    This button opens up the Execute Program screen.

Remove
Remove the currently selected command.

Up
Move the selected command up one position.

Down
Move the selected command down one position.



Features
You have made a wise choice!    Setup Factory 4.0 represents a revolution is setup authoring tools.    
Quite simply, there is no other setup authoring product available that puts as much power into your hands 
as easily as Setup Factory.

Some of the benefits of using Setup Factory appear below...

An object-oriented project approach provides flexibility and ease of use.

Completely visual interface.    No programming, script languages, configuration files or other 
complex nonsense!

Full control over adding, removing or modifying any file in your project.

The Setup Factory Project Wizard can have you up and running in minutes.    By simply 
answering a few questions, Project Wizard is able to generate a custom project for you in record time.    
And, unlike other less capable tools, you have the power of Setup Factory's menu commands at your 
disposal to help fine-tune and customize your project.

Setup Factory is completely automatic.    Once your project is ready, simply click on the build 
button.    Setup Factory will compress your data, calculate CRC-32 values to ensure data integrity, and 
create your customized installation program.

Setup Factory creates single file setups!    When you tell Setup Factory to build your disk set, all 
of your files are compressed and automatically combined into the Setup.exe file.    Of course, you are the 
boss!    You can tell Setup Factory to split this file up over multiple disks or simply output the whole thing to
your hard drive (a great convenience for Internet or other online distribution of your software!).

You have incredible control over the appearance of your installation.    Choose from a virtually 
unlimited array of background wallpaper options, such as gradients and patterns, bitmap tiling, header 
and footer text with great effects such as shadowing, and much more.

You control which screens will appear during your installation with a single click of your mouse.    
If you want to verify a password, display a license agreement or prompt for the user's name, just click the 
appropriate "Display this Screen" box!

Generate an uninstall program to assist your users in removing your software from their systems. 
This is a Windows 95 logo requirement, and Setup Factory can do it all with just one click!

Support for Selective Installations.    Group your files into "packages" and assign them to a type of
install (Complete, Typical, Minimum and Custom).    The graphical Package Manager makes all of this 
incredibly easy and your users get the ultimate in flexibility!

Full control over all installation messages including prompts and errors.    You now have the 
freedom to use Setup Factory for software distribution on a global scale.    In fact, Setup Factory comes 
with a number of pre-made "Language Modules" that you can use right out of the box!    Of course you are
always free to modify the language modules to meet your needs!

Bat/Sys File Editor allows you to modify the AUTOEXEC.BAT, CONFIG.SYS or any other text file.

INI file editor allows you to modify INI files like WIN.INI and SYSTEM.INI.

Registry Editor allows you to modify the Windows Registry.

Shortcut Editor lets you create folders (program groups) and shortcuts (icons) for files that were 



not installed by Setup Factory.    Great for CD-ROM based installations!

You have full control over    the install destination of your files.    Setup Factory even features the 
use of Inline Variables which are resolved at install time for determining the location of the user's 
Windows, System and Font directories.

Add Password checking to your installation to help reduce unauthorized distribution.

End user system configuration checking included.    Detects Windows version, color depth, screen
resolution and more.

Setup Expiration Checking allows you to specify a date when your installation will either disable 
itself or notify the user that the software they are trying to install is an old version.    This is a great feature 
when distributing demos or time-sensitive data!

Collect up to 10 fields of information from the user during the installation.    This information can 
be used by any of the Setup Factory editors as Inline Variables.    You can then write out this information 
to a file, pass it to another program on the command line, etc.

Many other features are packed into Setup Factory!    Some of the best ones are the ones you 
never see.    Setup Factory does its best to automate as many things as possible and make sure    that 
you are not doing something that doesn't make sense.    You'll discover these gems on your own!



File Menu
The file menu is used to manage your Setup Factory Project files (*.sfp), as well as to exit the program.

New
Creates a new Setup Factory Project, resetting all screens with their default values and clearing the 
Project Window.    If you already have a project open when you select New, you will be asked if you would 
like to save any changes that have been made before creating the new project.

Open
Opens a project that you saved previously using the Save or Save As commands.    All screens and 
options will be restored to those of the opened file.    Note that Setup Factory saved projects have the .sfp 
file extension by default.

Save
Saves the current project using the current project file name.    If you have not saved your project yet, you 
will be prompted for a file name.    The project can later be opened using the Open command.

Save As
Saves the current project.    You will be prompted for a file name for the project in a dialog box.    If you do 
not specify a file extension, the extension .sfp will be used.

Exit
Choosing Exit will shut down Setup Factory and return you to your Operating System.    If there are any 
unsaved changes in your project, you will be given the opportunity to save them before exiting.



File Properties
By selecting a file (or files) in the Project Window and then choosing File Properties from the Project 
menu, you will be able to view and edit the properties for the file(s).    If you have selected only one file 
when you use this option, the regular File Properties screen will be opened.    If you have more than one 
file selected, the File Properties (Multiple Files Selected) screen will be opened.    Note that on the 
Multiple Files Selected property screen, you will not be able to change as many options as on the single 
file property screen.

The File Properties screen is separated into the following tabs:

General
Shortcut
Advanced



File Properties - Advanced
General Section

Compression level
The level of compression that Setup Factory uses for the file.    The options are High, Medium and Low.    
This field is also available on the File Properties (Multiple Files Selected) screen.

Setting the Compression to Low will cause your files to decompress quicker during the installation 
process, however the installation will take up more of your distribution disk space.

Conversely, setting the Compression to High will cause your files to decompress slower during the 
installation process, however the installation will take up less of your distribution disk space.

Optimize for file type
The optimization method that should be used to compress and decompress the file.    The options are 
Binary and Text.    Text compression will yield the best compression results for text-type files such 
as .txt, .doc, .rtf, .wri, etc.    All other files should generally use Binary compression.    This field is also 
available on the File Properties (Multiple Files Selected) screen.

Member of this package
A list of all available packages that the file can belong to.    From this list, select the package that the 
selected file should belong to.    If you want this file to always be installed, select "None" as the package.   
This field is also available on the File Properties (Multiple Files Selected) screen.

Special Section

Register this file as a TrueType font
If checked, Setup Factory will attempt to automatically register and implement this file as a TrueType font 
during installation.    This means that the font will be registered with the operating system and will be 
made available to the user.    In order for this to work, the file must be a valid Windows .TTF file.

Font name
The name of the TrueType font that will be entered in the registry.    You can click the Auto-Name button 
beside this field to automatically scan the file and try to determine its embedded name.    If the Auto-Name
returns"Unknown" then the file is most likely not a valid Windows .TTF file.

Auto-Register ActiveX
If checked, the setup program will try and register this file using dllRegisterserver.    This will work for any 
ActiveX control or OLE server that properly supports the "Automatic Registration" specifications.    This 
option will work with both 16 bit and 32 bit setups.    If you find that your control is not getting registered, 
the cause is most likely a missing support file, or under Windows 3.1, missing OLE system files.    Make 
sure you refer to your control's documentation to determine its dependencies.



File Properties - General
File Information (Read Only) Section

The properties listed in the File Information section are read-only and are strictly for informational 
purposes.    

Name
The name of the file.

Source
The path of the file on your system.

Size
The size of the file in bytes.

Date
The date and time when the file was last modified.

Archive
If checked, the file has the Archive attribute set.

Hidden
If checked, the file has the Hidden attribute set.

System
If checked, the file has the System attribute set.

Read Only
If checked, the file has the Read Only attribute set.

File Destination Section

Install to this directory
The directory that you want the file to be installed to on the user's system.    You can use any directory-
related Inline Variable here by itself or in combination with a path that you specify.    This field is also 
available on the File Properties (Multiple Files Selected) screen.

Note:    Setup Factory will insert the correct directory here by default when you add the files to the project. 
Generally, you should not need to change the Install to this directory setting.

If a file is already there
The action that will be taken if a file with the same name as this one already exists in the directory that we
are installing this file to.    The relative "newness" of a file is determined by its time and date stamp.        
This field is also available on the File Properties (Multiple Files Selected) screen.    The options are 
Overwrite only if our file is newer, Always overwrite, Never overwrite, Ask the user what to do and Ask the
user what to do only if our file is older.

Note:    It is generally not a good idea to select Always overwrite unless you are extremely sure that is 
what you need to do.    Also, do not select Ask user what to do unless you are sure they have the 
knowledge to make such a decision. Ask the user what to do only if our file is older is generally the safest 
and most conventional option for this situation.





File Properties - Multiple Selection
The options on the File Properties (Multiple Files Selected) screen have the same meaning that they do 
when applied to a single file except that they will be applied to all files that were selected when File 
Properties was chosen.    For a description of any of these fields, see the information in the File Properties
screen.

If a field on this screen is left blank when OK is clicked, the selected files will retain the settings that they 
had before File Properties was chosen.    If a field has any text in it when OK is clicked, the changes will 
be made to all selected files.



File Properties - Shortcut
General Section

Create Start menu shortcut / Program Manager icon
If checked, the file will have a shortcut created in Start menu > Programs > %AppFolder% under 
Windows 95 and NT 4.0, or an icon created in Program Manager > %AppFolder% under Windows 3.1 
and NT 3.51.    The Inline Variable %AppFolder% is expanded at install time to represent the folder that 
the user wants to add the shortcuts to.    If you do not check this box, all other information in this section 
will be disregarded by the program and a shortcut will not be created.

Description
This is the description that will accompany the shortcut.    By default, Setup Factory uses the file name as 
the description.    For example, if the current filename is "BMPEDIT.EXE" the description will be 
"BMPEDIT.EXE" by default.    You will most likely want to change this to something more meaningful and 
descriptive.

Note:    Under Windows 3.1 or Windows NT 3.51 there is a limit of 40 characters for an icon description.    
Under Windows 95/NT 4.0, you can enter up to 255 characters for a shotcut’s description.

Advanced Section

Arguments
This is the text you want to pass to the program on the command line.    For example, many programs can
start up their document files by passing the document filename as a command line argument.    Of course 
all of this is dependent on the particular program you are passing the arguments to.    Note that you can 
use any of the Inline Variables here.

Working dir
The working directory of this file will be set by this field.    Note that you can use any of the Inline Variables
here.    If you do not enter any text here, Setup Factory will set the Working Directory to the same path 
that the file is installed to.

Icon path
This is the path to a valid Windows .ICO file to display for the shortcut.    This path must refer to an .ICO 
file that exists after the installation, therefore the Inline Variables such as %AppDir% should be used to 
qualify the path.    If you do not enter any text here, Setup Factory will assume that you want to use the 
icon that is embedded in the file, or if no icon is embedded in the file, use the default Windows provided 
icon for that file type.

Hint:    You can check if your icon file is a valid Windows icon file by creating a new shortcut (File | New | 
Program Item in Windows 3.1, NT 3.51 or right mouse click | New | Shortcut in Windows 95, NT 4.0) and 
trying to use your icon file to represent it.    If Windows can't use your icon, neither can Setup Factory.

Icon index
You should use this field to specify an icon index if the file selected in Icon path has more than one icon 
included in it.    By default Setup Factory will use the first icon it finds in your file (i.e. Index 0).



Finding Out What System Changes Must Be Made
The next area to think about is what, if any, changes must be made to system files such as the WIN.INI, 
SYSTEM.INI, the Registry, and the CONFIG.SYS and AUTOEXEC.BAT files.    All of these files can be 
modified by Setup Factory during the installation process.    The method for implementing these various 
changes is documented elsewhere in this manual.

If you are using Visual Basic 4.0, for example, you may have to make changes to the Registry.    Consult 
your development tool documentation for details of what these changes are if you are not sure.



If you have specified a folder name such as "Accessories" or "%AppFolder%, the folder will be created in 
the Programs section of the Windows 95 Start menu.    Under Windows 3.1 or Windows NT 3.51, a 
program group with this name will be created.

If the text in Folder is the name of a directory such as "%Desktop%\%AppFolder%", the folder will only be 
created under Windows 95 or Windows NT 4.0.    Nothing will happen during installation under Windows 
3.1 or Windows NT 3.51 if the folder name is a directory.



General Screen Design Layout
All of the design screens have been arranged to give you a good idea of what they will look like during the
installation.    All of the screens have the following features in common:

Display this screen
If checked, the screen will be displayed during the installation process.

Title Box
The long text box directly below the Display this screen checkbox.    The text that you enter here will be 
displayed in the title bar of the screen.    For example, if we are working on the Welcome Message screen,
appropriate text for this field would be something like "Welcome", "Introduction", or perhaps the name of 
your product.

Message Box
The large text entry box on the right side of the screen.    This is the text that will be displayed on the 
screen during installation.    The type of information that you enter in this box will vary from screen to 
screen.    The amount of text that you can enter in this box is fixed for all screens except for the License 
Agreement and Read Me Message screens.    These three screens feature a scrolling text box which 
allows you to display a longer message.

Image Preview
The large area that takes up most of the left side of the design screen.    This is the image that will be 
displayed on the screen during installation.    You can stick with the default image or load one of your own 
by clicking the Select Image button below the image.    The image you select here will be automatically 
resized to 135x223 and color optimized by Setup Factory.    You can control the color optimization by 
using the Images tab    of the Build | Settings command.

Select Button
Click on this button to select an image to display in the Image Preview area.    The acceptable image 
formats are bmp, pcx, tga, tif, jpg and gif.    If you have any trouble using your particular image, try using a
bmp file as this is the native Windows format and is used internally by Setup Factory.    You will notice that
Setup Factory ships with a number of images that you may use in your installations.    They are stored by 
default in the C:\SUF40\IMAGES directory.

Clear Button
Click on this button to clear or unload the image from the screen.



Getting Technical Support
Indigo Rose Corporation provides unlimited technical support (within reason) for the Setup Factory 
product.    You are entitled to 90 days free telephone technical support from the day that you first contact 
us for technical support.    After that period you can get free technical support by email or fax.

Please carefully read this manual and the Setup Factory Help file before seeking technical support.    
Many of your questions may be answered and much time and confusion can be avoided this way.    We 
have designed this manual to be a comprehensive guide to using this product, so please read it.

When you contact us for technical support, please have the following information ready:

Setup Factory serial number.    Your serial number is printed on the label of the first install 
diskette.

Registered user's name and company name.
Setup Factory version and build number.    You can find out the exact version number by selecting

Help | About from the Setup Factory main menu.
The module that you are using (i.e.. Windows 95 or Windows 3.1).
The operating system you are running Setup Factory on (e.g.. Windows NT 3.51 Build 1057).
The operating system you are running the Setup.exe on (e.g. Windows 3.1 with Win32s 1.3)
A very precise and detailed description of your problem or question.    If you are getting an error 

message, please send the exact wording of the message and describe when it occurs.
If the problem that you (or your user) is experiencing involves the system crashing, hanging, or 

giving a system error message, please include a Microsoft System Diagnostic report.    You can generate 
a report from DOS by typing "MSD /F FILENAME.TXT" where FILENAME.TXT is the name of the file that 
you wish to output this to.    Please send MSD reports only by email.

The best way to receive technical support is to email the above information to us via the Internet.    Our 
software support address is Support@IndigoRose.com.    We check our email at least once per day, so 
you can be sure that we will attend to your messages promptly.

If you do not have Internet access, you can FAX this information to (204) 942-3421.

If your problem is very urgent and none of the other support methods are available to you, call (204) 946-
0263.    Please note that you will save yourself a lot of time by ensuring that you have all of the information
about the problem in front of you BEFORE you call.    Also note that in order to keep costs down we will 
not return technical support messages left on our voice mail.    If we are not in when you call, please try 
back later.    Our regular office hours are Monday - Friday from 9:00 AM - 5:00 PM (Central Standard 
Time).

We appreciate hearing from our customers and routinely incorporate their suggestions and wishes into 
our products.    If you have any specific need or feature you would like added to this product, please write 
or call.



Help Menu
Contents
Choosing Contents from the Help menu will open the Setup Factory help file contents.    The contents will 
list the various subjects that you can refer to in the help file.    It is very similar to the table of contents you 
see at the front of a book.    This is a good command to choose if you are interested in browsing through 
the help file and getting a general overview of the available topics.

Index
Choosing Index from the Help menu will open the Setup Factory help file index.    The index contains a list
of keywords that you can search through.    It is very similar to the index you would find at the back of a 
book.    This is a good command to choose if you want to search for a particular topic.

Project Wizard
Choosing Project Wizard from the Help menu will start the Setup Factory Project Wizard which will assist 
you in getting your project off to a good start.

The Project Wizard is a great way to start any Setup Factory Project.    The Project Wizard will ask you to 
answer a few simple questions and then generate a custom project for you.    For a walk through of the 
Project Wizard, see the Tutorial.

Tutorial
Choosing Tutorial from the Help menu will open the help file to the tutorial section.    This on-line tutorial is 
very similar to the one in this manual.

Technical Support
Choosing Technical Support from the Help menu will open the help file to the Technical Support section.    
You will find valuable information here that will help you get the technical support you need.

Ordering Information
Choosing Ordering Information from the Help menu will open the help file to the Licensing & Ordering 
Information section.    This is where you can find out about ordering additional copies of Setup Factory 
4.0, purchasing other Setup Modules such as the "Windows 3.1 - Wizard", and find out about other Indigo
Rose products.

About
Selecting About from the Help menu will open the About Box which contains copyright and version 
information for Setup Factory.



INI File Command
Filename
The path and name of the INI file.    You would normally use one of the Inline Variables here to qualify your
path.    For example, to edit the WIN.INI file which is located in the Windows directory, you would enter: 

%WinDir%\WIN.INI
or to specify the file BMPEDIT.INI in your application directory, you would enter:

%AppDir%\BMPEDIT.INI
Note that you may choose from some common defaults from the drop-down list.

Action
The action to perform on the INI file.    Below is a description of available Actions.

Add or Append - Adds the value specified in Value to the key specified in Key in the section 
specified in Section.    If the key already exists in the ini file,    the new value will be appended to the end of
the existing value.    If the ini file, section, key, or value do not already exist, they will be created.

Add or Replace - Adds the value specified in Value to the key specified in Key in the section 
specified in Section.    If the key already exists in the ini file,    the new value will replace the old value.    If 
the ini file, section, key, or value do not already exist, they will be created.

Delete Key - Deletes the key specified in Key and its value from the section named in Section 
from the file.

Delete Section - Deletes the section specified in Section and all of its keys and values from the 
file.

Section
The section that the INI command will be applied to, such as [Fonts] or [Desktop].    Note that you must 
not include the "[ ]" brackets when specifying the section - they will be added for you.    If the section does 
not exist in the INI file, Setup Factory will create the section for you.    You may choose from some 
common defaults from the drop-down list.

Key
The key that will be used to reference the value contained in the section specified in Section above.    If 
the key does not already exist in the section, it will be added to the section and associated with Value 
below.    The Key is the left side of the "=" in an ini file (eg. Key = Value).

Value
The string that will be associated with the key specified in Key above.

Example 1 - Changing the cursor's blink rate in the WIN.INI file
Example 2 - Creating an extension association in the WIN.INI file



INI File Editor...
Choosing INI File Editor from the Project menu will open the INI File Editor.

The INI File Editor screen consists primarily of a large text box.    This screen contains a list of all INI file 
modifications that will be made during the installation.    Each modification is on its own line, therefore 
each line in this list represents one INI File Command.    The commands in this list box will be executed in 
top-down order during installation.

Note:    INI file changes are really only necessary and useful under Windows 3.1.    Microsoft recommends
using the Registry to set application settings when using Windows 95/NT.

You can create and order your INI File Commands using the buttons on the right side of the screen:

Add
Opens the INI File Command screen which allows you to create an INI File Command.    The command 
that is created will be added to the end of the list.

Insert
Opens the INI File Command screen which allows you to create an INI File Command.    This new 
command will be inserted directly above the command that was highlighted before clicking the Insert 
button.

Edit
Opens the INI File Command screen and allows you to edit the currently selected INI File Command.

Remove
Removes the currently selected INI File Command from the list.

Up
Moves the currently selected INI File Command up one position in the list.

Down
Moves the currently selected INI File Command one position down in the list.



Import Visual Basic Project
You can import the dependency files for a Visual Basic project right into Setup Factory.    Just fill out the 
fields and then click OK to add the dependencies.    Setup Factory will scan your project file and add the 
files to your project.    Please note that while our VB import support is extremely good, it is always possible
that some 3rd party controls may not follow industry conventions.    This is especially true for VB3.    As 
always, be sure to test your installation on as many different systems as possible before distributing.

Visual Basic Information
Project File
The name of the Visual Basic project file that you want to scan for dependencies.    In VB3, the filename 
will end in ".mak"; in VB4 or VB5, the filename will end in ".vbp".

VB Directory
The Visual Basic directory on your system.    Setup Factory will scan this directory's kitfiles before looking 
elsewhere, such as the System directory.    This is especially import if you are using VB4-16 on a 
Windows 95 system.    In such cases, the kitfiles directory contains the 16 bit ole files etc that are needed 
on Windows 3.1.

VB Version
The version of Visual Basic that was used to create the project.

DAO/ISAM Support
These checkboxes are used to add DAO support for many popular ISAM database formats.    If you don't 
know whether or not you need to use these options, you probably don't.    The Jet Support and ODBC 
Direct are workspace support options and they apply to VB5.    See your VB5 documentation for more 
details about workspaces. 



Inline Variables
Inline Variables are used to describe things that can not be determined at design time.    They generally 
represent items that can change from system to system or to reflect responses from the user of the setup 
program.    They are particularly useful in the editors (Bat/Sys Editor, INI Editor, Registry Editor, Shortcut Editor)
and on the File Properties screen.    You will normally use Inline Variables whenever you are specifying the path
to a file, such as setting the install destination of a file to %AppDir%.

Descriptions of the Inline Variables appear below.

%AppDir% - The full path that the user chose to install to.
%AppDrv% - The drive that the user chose to install to.
%CommonFiles% - The common directory for shared application files (Win95/NT4).
%DAOPath% - The location for DAO components (Win95/NT4).
%FontDir% - The user's font directory path.
%ProgramFiles% - The default root directory for application files in Windows 95/NT4.
%SrcDir% - The full path that the user installed from.
%SrcDrv% - The drive that the user installed from.
%SysDir% - The user's System path.
%WinDir% - The user's Windows path.
%Custom1% - %Custom10% - The custom variables as defined when you use the collect info screens 1-
10, respectively.

The following Inline Variables are primarily used in the Shortcut Editor:

%AppFolder% - The folder that the user chose to create the shortcut icons in.
%Desktop% - The path to the user's Desktop directory.
%StartMenu% - The path to the user's Start Menu directory.
%StartProgs% - The path to the user's Start Menu\Programs directory.

Remember to include the percentage signs ("%") as they appear in the list above.



License Agreement...
The License Agreement screen is used to display the license agreement for your software (or any other 
agreement) that you want the user of your software to agree to before installation takes place.    The text 
that you enter in the Message Box can be quite lengthy and scroll bars are provided.

The single line edit box below the Message Box is used to display the "I accept the agreement" message. 
During the installation a check box will appear beside this text.    The user must check to box before the 
installation will continue.    See General Screen Design Layout for more details about the fields on this 
screen.



Licensing & Ordering Information
Now that you have tried out the evaluation version of Setup Factory 4.0 and have seen just how useful it 
is, here is your big chance to order a commercial version of Setup Factory 4.0!    Please note that all 
prices listed are in USA dollars.    Product specifications and pricing is subject to change without notice.

What do I get when I order Setup Factory 4.0?
When you order Setup Factory 4.0, you will receive the following:

Setup Factory 4.0 program disk with the latest revisions and enhancements!

The 32 bit Setup Module ("Windows 95 - Wizard").    This module lets you build 32 bit setups that 
work with Windows 95, Windows NT 3.51 or greater and Windows 3.1 with the Win32s extensions.    This 
module makes full use of the features available on these 32 bit operating systems such as long filenames,
registry editing, control panel registration of the uninstall and dll/ocx usage count registration.

The 16 bit Setup Module ("Windows 3.1 - Wizard").    This lets you build 16 bit setups that work 
with Windows 3.1 or greater, Windows 95 and Windows NT.    This module provides almost identical 
functionality as the 32 bit module, except for obvious differences such as long filenames and 32 bit 
specific registry editing.

A license to distribute, royalty-free, the setup programs that you create with Setup Factory 4.0!

A professionally bound and printed manual with command reference, tutorial and much more!

No mention of our product or company name during your installation whatsoever!

Free technical support for as long as you need it.    Technical support by phone, fax and email is 
free for the first 90 days (you only pay for the call).    After that, you can still get help by email and fax for 
no charge!    How many of our competitors can say the same?

We keep you up to date by offering terrific pricing on upgrades to new versions, special deals on 
related products, and of course free bug fixes and minor updates to Setup Factory 4.0.

The peace of mind knowing your installation program is created by Indigo Rose Corporation.    
Our installation technology is being used in thousands of products all over the world and we have been 
producing Windows based installation solutions since Windows 3.0 was a baby!    We have been around 
and will continue to develop and support our setup authoring tools.

How much does it cost to buy a Setup Factory 4.0 license?
Surprisingly little!    At only US$229.95, Setup Factory 4.0 will pay for itself the first time you use it.    The 
amount of time and effort you save will keep paying you back for many months to come!.

I want to upgrade from an older version of Setup Factory!
If you already own a previous setup authoring tool made by Indigo Rose, such as Setup Factory 3.x or 
Doughboy Professional Install, you can upgrade to Setup Factory 4.0 for the great low price of only 
US$129.95!

Make sure you include the serial number from your old version when filling out your order form.

What if I want to buy multiple licenses?



If you have a number of setup authors at your company and would like to order copies of Setup Factory 
4.0 for them, Indigo Rose offers multiple copy discounts.    For 3-10 copies we offer a 10% discount.    For 
11-25 copies we offer a 15% discount    For 26-49 copies we offer a 25% discount.    For 55-99 copies we 
offer a 30% discount.    Please call for pricing on 100+ copy orders.

I've got deadlines!    How long will it take for delivery?
Indigo Rose Corporation ships all orders received before 2:00 PM Central Time for next business day 
delivery by Federal Express.    For customers outside the USA and Canada please allow 2-5 days for 
delivery.    Please note that shipping charges are subject to change without notice, especially to 
destinations other than USA and Canada.    Please call, fax or check our Web site for the current shipping 
charge.    For those customers outside the USA and Canada we can optionally ship your order by Postal 
Air Mail for US$10.00, but please be prepared to wait 3-6 weeks for delivery.

Destination 1st Unit Each
Additional

USA $15.00 $8.00
Canada $10.25 $4.55
Belgium, England, France, Germany, Ireland, Italy, Netherlands, 
Scotland, Wales

$25.00 $10.00

Austria, Denmark, Finland, Greece, Hong Kong, Japan, Norway, 
Portugal, Singapore, Spain, Sweden, Switzerland, Taiwan

$26.50 $10.00

Bahamas, Bermuda, Haiti, Mexico $26.50 $12.00
Australia, Egypt, Isreal, Kuwait, Philippines, South Korea, New 
Zealand

$33.00 $18.00

Argentina, Brazil, Chile, Columbia, Guyana, Honduras, India, 
Panama, Paraguay, Peru, Uruguay, Venezuela

$38.00 $18.00

Algeria, Bulgaria, Fiji, Hungary, Iceland, South Africa $46.00 $20.00

Setup Factory 4.0 is like sliced bread!    How do I order?
You can either order direct from Indigo Rose Corporation, or you can call up you favorite software dealer 
and ask for "Indigo Rose's Setup Factory 4.0".    If your dealer is confused, have them call us at (204) 946-
0263 and we'll be pleased to enlighten them!

To order direct from Indigo Rose Corporation:
Print out the order form, fill in your information and then fax it to (204) 942-3421.
Have your VISA, Mastercard or AMEX card ready and call our order line at 1-800-665-9668.
International customers, have your VISA, Mastercard or AMEX card ready and call us at (204) 

946-0263.
Print out the order form, fill in your information and then mail it to the address on the order form.

A convenient order form is available by clicking here -> Ordering Form.

Canadian customers, please click here -> Canadian Ordering Form.

Nothing else comes close to Setup Factory 4.0!    You can not find an easier to use setup authoring tool 
with this much power and flexibility.    You could go with another product, but then you would be paying 
more and getting less.    Don't be fooled!    Make sure it says Indigo Rose' s Setup Factory in the About 
box!

123 Bannatyne Ave., Suite 230



Winnipeg, MB, Canada R3B 0R3

Orders: (800) 665-9668
Phone: (204) 946-0263
Fax: (204) 942-3421
Email: Support@IndigoRose.com
Web: http://www.IndigoRose.com



Menu Commands
To find out more about a particular menu heading and what commands appear on that menu, click on one
of the following links...

File Menu
Project Menu
Screens Menu
Build Menu
View Menu
Help Menu



Message Manager...
The Message Manager is used to customize the messages, information, errors and buttons that appear in
a Setup Factory installation.    Although the main purpose of the Message Manager is to allow you, the 
setup author, to translate the install messages to a language other than English, it can also be used to 
make the messages more clear or understandable to your users.

Note:    Any text that is system dependent such as the OK or Cancel buttons on an error box will be 
displayed using the language of the user's operating system.

In Setup Factory, Language Modules are stored with the .LNG extension.    You can create as many 
different .LNG files as you need.    The Language Module file that is specified in Build | Settings in the 
Language field will be used during the installation.

The Message Manager screen has the following options:

Currently loaded language module
The full path and filename of the .LNG file that you are editing.    You can load in a different .LNG file by 
using the Open button on the right side of the screen.

Messages
This list contains all of the messages that could appear during the installation.    To edit a message, click 
on it and then choose the Edit button on the right side of the screen.

Open
Click on this button to open a screen that will allow you to browse your drives and directories for the 
Language Module (.lng file) that you want to edit.

Save As
Click on this button to save the currently open language file with the same or a different name.

Edit
Clicking the Edit button will open the Edit Message screen and allow you to change the currently 
highlighted message.



The file that we are installing will never overwrite an existing file with the same name.



Order Form for Setup Factory 4.0 #7620
230-123 Bannatyne Ave., Winnipeg MB, Canada R3B 0R3 Fax this sheet to (204) 942-3421

Ship To:

Name:                                                                                                                                                                                   

Company:                                                                                                                                                                                   

Address:                                                                                                                                                                                   

                                                                                                                                                                                  

City:                                                                                                         State:                                                 

Country:                                                                                                         Zip:                                                 

Phone:                                                                                                         Fax:                                                 

Email:                                                                                                                                                                                   

Serial # (if upgrading):                                                                                                                                                                   

How did you find out about Setup Factory?                                                                                                                             

Method of Payment:
Please note that credit cards are charged in Canadian dollars at the current USA-Canadian exchange rate (but don't worry, the correct amount will 
show up on your credit card statement in your local currency).    Checks must be drawn on a Canadian or USA bank with the appropriate international 
routing codes.    For wire transfer to our bank account, please contact us for details.    We also accept purchase orders from qualified corporate and 
educational accounts on terms Net 30 (subject to approval).

___ VISA ___ MasterCard ___ American Express           ___ Check ___ Wire Transfer

                                                                                                                                                                                                  /               
Card # Expiration Date
                                                                                                                                                                                                                  
Cardholder's name
                                                                                                                                                                                                                  
Signature - Cardholder will pay total amount shown to card issuer according to cardholder agreement with card issuer.

Product to Order and Pricing (All prices in US$):
    Product     Qty     Price     Total
    Setup Factory 4.0     $229.95
    Duplication Factory for Windows 95/NT     $49.95
    Upgrade to Setup Factory 4.0 from Setup Factory 3.x     $129.95

* Shipping - See Shipping Chart     Shipping*

 Total (US$)



If the file that we are installing is newer than the existing file, then overwrite the existing file.



Package Information
General Section

Package name
The name you would like to give to the package.    The name should be something meaningful such as 
"Help Files" or "Samples", rather than something generic like "Package 1".

Package description
A short description that will be of use to those users who select the Custom install type.    This should be a
short, concise description such as "The help files for XYZ Program."

Membership Section

The Membership section lets Setup Factory know which install types this package belongs to.    The 
options are Complete installation, Typical installation, Minimum installation and Custom installation.    If 
the box beside the installation type is checked, this package will belong to that installation type.

Adding Files to Packages
To add files to the Packages that you have created:

From Setup Factory's Main Screen, select the file(s) that you want to add to a particular package.
Select Project | File Properties.
Select a package for the file(s) to belong to in the Member of this package field.



Package Manager...
Note:    Please read the Packages - About Packages information before proceeding.

Selecting Package Manager from the Project menu will open the Package Manager.    The Package 
Manager is the cornerstone of Setup Factory's selective install feature.    Here you will be able to create, 
edit and remove packages from your project.    The general sequence you will follow when creating    a 
selective install is:

1. Add files to your project as you normally would.
2. Create your packages using the Package Manager.    For example, you could create packages called 
Graphics, Sounds, Help, Examples and Executables.
3. Determine which install type each package belongs to.    This relationship can be viewed and edited 
using the Package Manager.    Most often, this is done at the same time as step 2.
4. Return to Setup Factory's main screen and set the membership of each file in your project to the 
appropriate package.    This is done using the Project | File Properties command.
5. Go to Screens | Select Install Type and make sure Display this Screen is checked.    This is the step 
that will actually enable the selective install functionality.

Most of the Package Manager screen is taken up by a tree view that is used to graphically show your 
package relationships.    There are two main branches of this view, Installation Types and Unpackaged 
Files.

Installation Types has four sections, each of which can be expanded in order to see which packages 
belong to that type.    The four installation types are:

Important Note:    These installation types are our suggested installation types.    Although they are 
considered industry standard and we recommend you use them, you have the option of naming them 
anything you want from Screens | Select Install Type.    For example, you could name them "Type 1 
Install", "Type 2 Install", "Type 3 Install" and "You Choose".    It is important to note that the fourth install 
type will always have the "Custom" feel to it.    If the user chooses the fourth type during the installation, 
they will always be able to choose which packages to install.

Complete - All packages (and therefore all files) in your project will be installed to the hard drive.
Typical - This includes the packages that you believe most of the users of your software will want 

or need to use.    Although it varies with the nature of the software that you are installing, a Typical setup 
generally includes most or all of the files that are in your project.    It could exclude, for example, special 
drivers that only a limited number of users will need, extra samples, or extra documentation.

Minimum - The bare minimum installation for your software.    This would only include packages 
essential to your program.    This option would generally be used when installing to a laptop computer or a
computer with a minimum of hard drive space available.

Custom - This option will allow the user to choose which packages will be installed and which will 
not.    This option will most often be used by "power users" of your software who know what they are 
doing.

The Unpackaged Files section lets you view all of the files in your project that belong to the special 
package called "None".    These files will always be installed, regardless of the installation type.

The options on the Package Manager screen are:

New
Create a new Package.    The Package Information screen will be opened which is used to describe your 
new package.

Remove



Removes the selected package from the project.    Any files that are currently members of the selected 
package will be moved to the special package called "None".

Edit
Opens the Package Information screen and allows you to edit the selected package.    You can change 
the install types that the package belongs to, edit the name and the description.    All of the files that are 
currently members of the package will retain their membership.

Display file names
If checked, you will be able to graphically see which files belong to each package.    You may not want to 
have this box checked if you have a very large number of files as it can take some time to update the 
display.



Packages - About Packages
What is a Package?
In Setup Factory, a package is a logical or functional group of files.    All files in your project must belong to
a package.    By default your files will all belong to the special package called "None".    Files belonging to 
package None will always be installed.

The real power of packages comes into play when you want to create a selective installation.    A selective
installation is one in which you give the user a choice of four different package groupings (called 
installation types).    One installation type, called Custom install, allows the user to choose which 
packages will be installed to their system on a package-by-package basis.

Many setup authors will find that they do not have a need for selective installs, however a number of 
situations could benefit from them, such as:

If your installation has certain files that are optional or that every user may not need.    An 
example of this could be if you are distributing a multimedia presentation that uses a certain engine to 
run.    You may know that some of your users may already have the engine on their systems and that it is 
not necessary to install it again.    In this case, you could create a package that included all engine files 
and include it in the appropriate install types.

If your installation consists of several individual programs.    If you are an Internet Service 
Provider, for example, you may be using Setup Factory to give redistributable Internet software packages 
to your users.    You may be including four different pieces of software with your distribution and you want 
to let your users choose what ones they want or need to install.

If your installation is a large, CD-ROM based installation.    If you are distributing a large amount 
of data on a CD-ROM, you may want to let your users choose which packages to install to the hard drive 
such as help and data files, etc.



Part One - Simple Installation
In this first part we will create a distribution disk set and Setup.exe that does everything you would expect 
a good setup program to do.    We want it to display a welcome message, ask the user where to install the
files to, prompt for a folder to add the program shortcuts to and then install all of our files and notify the 
user when we are done.    The easiest way to do this is to use the Setup Factory Project Wizard.

Next Step



Part Two - Selective Installation
Now let's say that we want to let the user choose which of the three programs to install from the disk set.   
They may, for example, already have an Internet dialer that works just fine for them and they really don't 
want to install the new one.    We can do this by using the Package Manager.

Next Step



Preferences - Adding Files
Note:    All options on the Adding Files page will only be applied to new files that are added to the project.  
These options will have no effect on files that are already in the project.

Default Values Section

Existing file
When you add a new file to your project, the existing file option will be set to the value you choose here.

Package
When you add a new file to your project, it will become a member of the package you specify here.    The 
default is the special package called "None".

Compression
When you add a new file to your project, the compression level will be set to the value you choose here.

Optimize
When you add a new file to your project, the optimization type will be set to the value you choose here.

Time Savers Section

Create shortcut for *.exe
If checked, any files that are added to your project that have the .exe file extension, will automatically be 
marked to have a shortcut created for them.    It is generally a good idea to have this option turned on 
when first starting a project so that you don't accidentally forget about one of your .exe files.    You can 
always turn off the Create Start menu shortcut / Program Manager icon option for an individual file later is 
you wish.

Create shortcut for *.hlp
If checked, any files that are added to your project that have the .hlp file extension (i.e. a Help file) will 
automatically be marked to have a shortcut created for them.

Register *.ttf as font
If checked, any files that are added to your project that have the .ttf extension (i.e. a TrueType Font file) 
will automatically be registered and activated as fonts on the user's system when the installation is run.



Preferences - General
Temporary Files Section

Directory to store temporary files in
Setup Factory will use the directory you specify here to hold temporary files while building your disk set.    
Make sure that this directory is on a drive with an adequate amount of free space.    A good rule of thumb 
is take the number of bytes in your project and then double it to determine the amount of free space you 
will need to build your disk set.

Details View Section

Sort Order
The order in which the files will be sorted when viewed in Details view (see View | Details) on the Main 
Screen.    There are only two options - Ascending and Descending.

Ascending - The files will be sorted from A-Z if you have chosen to sort by a column containing 
alphabetic values such as Name or Source, etc. or from least to greatest if you have chosen to sort a 
column containing numerical values such as Size.

Descending - The files will be sorted from Z-A if you have chosen to sort by a column containing 
alphabetic values such as Name or Source, etc. or from greatest to least if you have chosen to sort a 
column containing numerical values such as Size.

Sort filenames by extension
If checked, the files on the Main Screen will be sorted (and therefore grouped) by their file extensions.    
All of the .exe files will be grouped together, for example.    This can make it easier to modify the file 
properties for many of the same types of files at once.

Startup Section

Show Welcome screen at startup
If checked, the Welcome screen will be displayed when Setup Factory is started.    If not checked, the 
Welcome screen will not be displayed.



Preferences...
The Preferences screen is separated into the following tabs:

General
Adding Files



Preparing the Directory Structure
The ultimate goal of a good installation program is to get your software onto the user's system in an easy 
and accurate manner.    Although Setup Factory ensures both you and your users ease of use, the 
accuracy of the installation is largely up to you.    By accurate we mean that your files will be installed in a 
structure in which they will function properly.

The best way to ensure an accurate installation is to have the software prepared in it's finished state on 
your development system before you begin to create the installation.    That is, have the entire directory 
structure and file locations the same on your system as you want them to appear on the user's system.

This way you can test the program in that structure before creating the installation.    Having the files and 
directories set up in such a manner ahead of time will also make the installation creation process much 
quicker and easier for you.



Preparing Your Software for Distribution
Although many of you are the jump-right-in types, it is very wise to carefully think out your installation 
before you start to create your project.    Many technical support calls could have been avoided over the 
past few years if the setup author would have taken the time to think about the installation before creating 
it.    Below are important steps that you should consider before embarking on the creation of an 
installation.

Determining the Files You Need To Distribute
Preparing the Directory Structure
Determining Where to Install Files on the User's System
Finding Out What System Changes Must Be Made
Windows 95 Considerations
CD-ROM Considerations
Testing Your Installation



Project Menu
Commands on the Project Menu are used to customize the functionality of Setup Factory.    Using 
commands on this menu you will be able to:

Add files to your project, remove files from your project and modify the properties of each file in 
your project.

Tell Setup Factory what minimum hardware and software configuration you expect your users to 
have.

Specify what to do after the installation is complete, such as executing programs or restarting 
Windows.

Have Setup Factory generate an uninstall program and customize its behavior.
Modify system files such as config.sys and autoexec.bat,    make changes to INI files like WIN.INI 

and SYSTEM.INI, add and remove registry entries and even create shortcuts that point to files that are 
not included in your project (such as CD-ROM based applications).

Group your files into packages, such as Documents, Examples, Help Files and Executable Files.  
These packages can then be used to provide a selective install option.    Your users will be able to choose 
the type of install to use, such as Complete, Typical, Minimum or Custom.

Modify the error and information messages used in the setup.    You are no longer bound to the 
English language!

Configure Setup Factory to work the way you want using the Preferences command.

Click on one of the following items for more information on that command:

Add Files to Project...
File Properties
Remove File from Project
Import Visual Basic Project...

System Minimums...
Execute...
Termination...
Uninstall...

Bat/Sys File Editor...
INI File Editor...
Registry Editor...
Shortcut Editor...

Package Manager...
Message Manager...

Preferences...



Project Window
A list of all of the files in your Project dominates most of the Setup Factory's Main Screen.    This list is 
intended to give you a visual representation of the files that make up your Setup Factory project.    From 
this list you can highlight specific files and perform actions upon them.    There are six headings on this 
screen by which you can view and sort the files in your project.

Name
The name of the file.

Source
The file's source path.    (Where it came from on the development system.)

Destination
Where the files will be installed to on the user's system.

Package
The package that the file belongs to.

Size
The size of the file in bytes.

Icon
Whether or not the file will have a shortcut (or icon) representation.

Hint:    To sort the files by any of the above categories, click on the header for that column.    To sort the 
files by their extensions, check Sort filenames by extension on the General page of the Preferences 
screen.



Read Me Message...
The purpose of the Read Me Message screen is, as the name suggests, to display information during the 
installation.    This screen is quite versatile and can be used for many purposes.    You may want to display
important information about the installation or usage of your software here.    Scroll bars have been 
provided on this screen so that you can display a lot of text.    The fields on this screen follow the outline in
General Screen Design Layout.

Hint:    You can paste text from the Windows Clipboard to the large box on this screen by clicking the 
mouse in the text entry box and then pressing Ctrl-V.



Ready to Install Message...
This is the screen that will appear right before the setup actually starts to install files and modify the user's
system.    This screen is always displayed.    

You would normally use this screen to tell the user what is about to happen.    This is also a good place to 
mention that this is the last chance to change any of the installation options before the installation process
begins.

The user will read this screen and then click on the Finish button to begin the installation.

See General Screen Design Layout for more details about the fields on this screen.



Registry Command
Action
The registry action to execute.    Below is a description of each action.

Create Key - Creates the key specified in Sub Key under the main key specified in Main Key.
Delete Key - Deletes the key specified in Sub Key and all of its keys and values under the main 

key specified in Main Key.
Set Value - Sets the value specified in Value in the key specified in Main and Sub Key.

Main
The main key to make the registry change to.    There are only four possible values: 
HKEY_CLASSES_ROOT, HKEY_CURRENT_USER, HKEY_LOCAL_MACHINE and HKEY_USERS.

Note:  Only the HKEY_CLASSES_ROOT is used by the Windows 3.1 registry.    If you choose any other 
value for Main Key the Registry Command will not be executed under Windows 3.1 (even under Win32s).

Sub Key
The sub key under the Main key that you want to modify with the Registry Command.    There should not 
be a backslash ("\") at the beginning of this value.

Type
The data type of the value.    The only two possible values here are REG_DWORD and REG_SZ.    
Always use REG_SZ if the value is a character string.    If the value is an integer, use REG_DWORD.

Note:    REG_SZ is the only acceptable value for this field if installing to Windows 3.1 (even under 
Win32s).

Name
The name of the value.    If you leave this field blank, Windows will assume you want to create an 
unnamed value ("No Name").

Note:    Windows 3.1 does not support the Name field.    This field will be ignored if installing to a Windows
3.1 system (even under Win32s).

Example 1 - Adding an application's directory to the 32-bit registry path
Example 2 - Creating an extension association in the 16 or 32-bit registry



Registry Editor...
Choosing Registry Editor from the Project menu will open the Registry Editor screen.    The Registry 
Editor is used to make changes to the Windows registry during the installation.    The registry is an 
advanced feature of Windows and if you do not know why you need it, you probably don't.    Haphazardly 
changing information in the registry can cause severe system malfunctions and we recommend that you 
edit the registry only if you know exactly what you are doing.

If you want to know more about the Windows registry itself, please do not contact our technical support 
department.    We will only provide support for the Setup Factory Registry Editor and not for the registry 
itself.    If you do wish to learn more about the registry, refer to a book on the subject or the Win32 API.

The Registry Editor screen consists primarily of a large text box.    This screen contains a list of all registry
modifications that will be made during the installation.    Each modification is on its own line, therefore 
each line in this list represents one Registry Command.    The commands on this screen will be executed 
in top - down order.

You can create and order your Registry Commands using the buttons on the right side of the screen:

Add
Opens the Registry Command screen which allows you to create a Registry Command.    The command 
that is created will be added to the end of the list.

Insert
Opens the Registry Command screen which allows you to create a Registry Command.    This new 
command will be inserted directly above the command that was highlighted before clicking the Insert 
button.

Edit
Opens the Registry Command screen and allows you to edit the currently selected Registry Command.

Remove
Removes the currently selected Registry Command from the list.

Up
Moves the currently selected Registry Command up one position in the list.

Down
Moves the currently selected Registry Command one position down in the list.



Remove File from Project
Removes the currently highlighted file(s) from the project.



Screens Menu
The Screens menu allows you to select and customize the screens that appear in your installation.    You 
will quickly notice that any screen with a check mark beside it has been selected to appear during the 
installation process.

Wallpaper...
General Screen Design Layout
Welcome Message...
Read Me Message...
License Agreement...
Verify Password...
Collect Information
Select Install Type...
Select Install Directory...
Select Shortcut Folder...
Ready to Install Message...
Read Me Message...
Closing Message...



Select Install Directory...
This screen is used to ask the user where on their hard drive that they want to install your software. 

Default installation path
The text that will appear as the default path on the Install Location Screen during installation.    Although it 
is always a good idea to enter Suggested Path, you must enter one if you want to lock the user drive 
and/or directory (see below).

Lock Drive
If checked, the user will not be able to change the drive that they are installing to from the one that you 
have specified in Default installation path.

Lock Directory
If checked, the user will not be able to change the directory that they are installing to from the one that 
you have specified in Default installation path.

Warning:    It is generally not a good idea to lock the user drive and/or directory unless you have a very 
specific reason to do so.

See General Screen Design Layout for more details about the fields on this screen.



Select Install Type...
You will only choose to display this screen if you want to enable the selective install capability of Setup 
Factory 4.0.    This screen will ask the user which installation type they would like to use.    There are 
always four install type options.    The defaults on this screen are suitable for most installations and should
only be changed if you have a good reason for making your installation "non-standard".

There are four sets of text entry boxes on this screen.    The one line box in each set is the label for this 
type of install.    The two line box below it is the longer description of what this install type does.

From the top of the screen to the bottom, the fields represent the Complete Install, Typical Install, 
Minimum Install and Custom Install respectively.    If, for example, you wish to have the Minimum Install 
called "CD-ROM Install" during the setup process, you could enter "CD-ROM Install" in the fifth box down 
from the top of the screen.

See General Screen Design Layout for more details about the fields on this screen.



Select Path Dialog
The Select Path Dialog allows you navigate through directories and drives to find a path.

Path
The currently selected path.    This is the path that will be returned when OK is pressed.

Directories
The directories on the currently selected drive.    To open a directory, double click on the folder next to the 
directory's name.

Drive
The currently selected drive.    You can select from any available local or networked drives.

Network
Click this button to open a dialog which will allow you to map a network drive.



Select Shortcut Folder...
This screen is used to ask the user which folder they would like to add program shortcuts to.    In Windows
3.1/NT 3.51 terms this refers to which Program Manager group they would like to add program icons to.

Setup Factory performs according to industry standard guidelines.    Under Windows 95/NT 4.0 the folder 
will be created in Start Menu > Programs > %AppFolder% where %AppFolder% is the name of the folder 
that the user selects.    Under Windows 3.1/NT 3.51 the folder will be created in the Program Manager 
window.

What the user will see during the installation is the message you enter in the Message Box, an edit box 
below the message and finally a list of the shortcut folders that already exist on their system.    The edit 
box will initially contain the name of the Default folder.

Default folder
This is the suggested folder that you would like your users to use.    You should always have a default 
folder so that inexperienced computer users will have a good starting point and not be confused.

Force user to choose the default folder
If checked, the user will not be able to change the Default folder.

Warning:    It is generally not a good idea to choose Force user to choose the default folder unless you 
have a very specific reason to do so.

See General Screen Design Layout for more details about the fields on this screen.



Settings - Expiration
The expiration feature of Setup Factory allows you to control how long the installation process will work 
for your software.    This feature is useful if you are distributing demos, evaluation software, or other time 
sensitive data.    Please note that if you are using this feature, it is critical that both your system time and 
the system time of your user's computer is correct.

Enable expiration checking
If checked, expiration date checking will be enabled during the installation.

Number of days before software expires
The number of days, calculated from the creation date, before the setup will expire.    Once the expiration 
data is reached,    the expiration message will be displayed.    The installation process will be aborted if 
Abort the installation if expired has been selected, otherwise it will act only as a warning notice.

Display this message when software has expired
The message that will be displayed when the user attempts to install the software after it has expired.

Abort the installation if expired
If checked, the installation will abort when the user attempts to install the software after it has expired.



Settings - General
Module Section
Platform
The platform that you are building the disk set for.    The options here will vary depending on which Setup 
Modules you have.

Setup Factory 4.0 ships with both the "Windows 95 - Wizard" and the "Windows 3.1 - Wizard" modules.

The Windows 95 module allows you to create native 32 bit setups which require either Windows 95, 
Windows NT 3.51 or Windows 3.1 with the Win32s 1.3 Extensions in order to run.    This is the ideal 
choice if your software is designed for Windows 95/NT.

The Windows 3.1 module is designed for 16 bit platforms such as Windows 3.1, Windows 3.11 and 
Windows 3.11 for Workgroups.    Since Windows 95/NT can run both newer 32 bit software and older 16 
bit software, the setups you create with the Windows 3.1 module will work fine on these operating 
systems as well, however a 16 bit setup can not take advantage of advances features of these operating 
systems such as long file names and 32 bit registry functions.

The bottom line here is that you should be using the Setup Module that matches the type of software you 
are creating the install for.    If you are distributing Windows 95/NT software, then use the "Windows 95 - 
Wizard" module.    If you are distributing Windows 3.1 software, then use the "Windows 3.1 - Wizard" 
module.

Language
The Language Module that will be used by the setup.    The language module contains all of the general, 
information and error messages that can be displayed during the installation.    You can click on the button
to the right of this field to browse for a language module.    Language module files have the .LNG 
extension and can be edited using the Message Manager command found on the Project menu.    Please 
note that certain "Common Dialogs" such as the Yes/No confirmations will appear using the language of 
the user's Windows operating system (i.e. They will be in English on English versions of Windows, or in 
French on French versions of Windows).

Setup Factory ships with a number of ready-made language modules, such as English, French, Spanish, 
German, Italian and Dutch.    Other language modules may be available from Indigo Rose Corporation.    
Please check out our web site for a current listing.

Main Window Section
Caption
The text that will appear on the title bar of the setup window during the installation process.    Most often 
this will simply say "Setup", but you can change it to anything you like.

Maximize window
If checked, the installation will run maximized and take up all available screen space during the install.    It 
is generally a good idea to have this checked.    Users tend to get confused when they see overlapping 
windows and a crowded screen.

Status Box Section
Position
The screen position at which the status box will appear.    The status box is the informational dialog that 
displays the name of the file that is being installed, a progress meter, and an optional animation file.    The 



choices are Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle Right, Bottom Left, Bottom
Center and Bottom Right.

Animation
The animation (*.avi) file that will run in the status box during the installation.    A button is provided to the 
right of this field so that you can browse for an animation file to use.    You can leave this field empty if you
do not want to use an animation file.

Setup Factory can only make use of simple animation files.    The animation file that you choose has 
certain restrictions:    It must be in AVI (Audio Video Interleave) format; There must be exactly one video 
stream that has at least one frame;    Audio streams are ignored;    It must be uncompressed or 
compressed with RLE8 compression;    No palette changes are allowed in the video stream.

What all of this means is that if the animation file you are trying to use does not work during the 
installation, you have a problem with the .avi file.    It is not a problem with Setup Factory.    Make sure you 
follow the guidelines mentioned above and things will work out for you.



Settings - Images
This page is used to determine how your images will be optimized by Setup Factory.    Setup Factory can 
either optimize your images for 16 color or 256 color displays.    The method it uses to do this can be fine-
tuned to your liking.    By setting the Palette to Standard, for example, Setup Factory can map all of your 
images to the same color palette so as to eliminate the palette shifting that would otherwise occur on 256 
color display adapters.

These settings apply to all images displayed during the installation including the Wallpaper bitmap and 
Wizard images.    In general, you can achieve the best looking images using 256 Colors, Optimized 
Palette, and Nearest Color.    This is assuming that most of your users will be using a 256 color display.    
Of course, only you can decide what will be best for your situation.    You may want to experiment a bit to 
find the best combination.

Note:  All of the image previews in Setup Factory (i.e. any screen from the Screens menu)    reflect the 
current Image settings.    The preview will provide you with a very good idea of how the image will look 
when you run the setup.

Color Depth Section

16 Colors
If selected, the images in your installation will be optimized for 16 color displays.

256 Colors
If selected, the images in your installation will be optimized for 256 color displays.

Palette Section

Standard
If selected, the images will be optimized to use a standard color palette.    The Standard palette option will 
give you the best results if you are using a Wallpaper Bitmap, rather than a pattern or gradient.    The 
reason for this is that by using a standard palette, all of your images (Background Wallpaper bitmap and 
foreground Wizard screen images) will be remapped to the same set of colors.    This means that the 
palette does not have to be changed every time a new image is displayed, which would result in the 
background image having to share the palette with the foreground image.    This "palette shifting" ends up 
producing something rather unattractive effects.    The Standard palette option can eliminate these 
cosmetic problems.

Optimized
If selected, the images will be displayed using an optimized palette for each image.    The optimized 
palette will attempt to choose the best 256 colors for your images instead of using a standardized palette. 
Keep in mind that using the optimized palette can distort the display of the images if you have more than 
one image on the screen at a time (i.e. a Wizard image and a Wallpaper bitmap).    If you do choose 
optimized palette, it is best to use a gradient or pattern background.

Reduction Method Section

Nearest Color
If selected, the images will be reduced using the nearest color method.    This is the best choice for most 
situations.

Dither
If selected, the images will be reduced using a dither method.    This option can sometimes produce a 
better 16 color image than Nearest Color can.



Scatter
If selected, the images will be reduced using a scatter method.    This option can sometimes produce a 
better 16 color image than Nearest Color can.



Settings...
The Settings screen is used to configure a number of options which affect the way your installation is 
built.    Most importantly, this is where you will choose both the Setup Module and the Language Module 
that you want to use.    The Setup Module you choose will affect both the final look of your installation and 
more fundamentally, the platform you are targeting it for.    The Language Module you choose will 
determine the text of all general, error and information messages that are displayed during the 
installation.

General
Images
Expiration



Setup Factory is Royalty-Free!
Unlike a number of competing products, Indigo Rose Corporation does not hassle you with restrictive 
royalty fees, or limit the number of installations you create with the commercial version of Setup Factory 
4.0.

You see, Setup Factory was designed to make your life easier.    We're not going to mess it up by hassling
you with endless details.    You pay the up-front license fee for Setup Factory 4.0 and then use it to create 
installations for your software.    We won't come to you at the end of the year and ask how many copies of 
your software you have sold.    We won't tell you to buy a new license for every product you create.    As 
long as you are the copyright holder of the software, you can use Setup Factory 4.0 to create the 
installation for it.



Shipping Chart
Indigo Rose Corporation ships all orders received before 2:00 PM Central Time for next business day 
delivery by Federal Express.    For customers outside the USA and Canada please allow 2-5 days for 
delivery.    Please note that shipping charges are subject to change without notice.    Please call, fax or 
check our Web site for the current shipping charge.    For those customers outside the USA and Canada 
we can optionally ship your order by Postal Air Mail for US$10.00, but please be prepared to wait 3-6 
weeks for delivery.

Destination 1st Unit Each
Additional

USA $15.00 $8.00
Canada $10.25 $4.55
Belgium, England, France, Germany, Ireland, Italy, Netherlands, 
Scotland, Wales

$25.00 $10.00

Austria, Denmark, Finland, Greece, Hong Kong, Japan, Norway, 
Portugal, Singapore, Spain, Sweden, Switzerland, Taiwan

$26.50 $10.00

Bahamas, Bermuda, Haiti, Mexico $26.50 $12.00
Australia, Egypt, Isreal, Kuwait, Philippines, South Korea, New 
Zealand

$33.00 $18.00

Argentina, Brazil, Chile, Columbia, Guyana, Honduras, India, 
Panama, Paraguay, Peru, Uruguay, Venezuela

$38.00 $18.00

Algeria, Bulgaria, Fiji, Hungary, Iceland, South Africa $46.00 $20.00



Shortcut Command
Here you can select the Shortcut Command that you want to execute.    All of the Shortcut commands 
require you to fill in one or more of the fields on this screen.    Once you choose the Shortcut Command 
that you want, you will only be able to edit the fields that are appropriate for that command.

Note:    Please read Folder Naming Rules before attempting to use shortcut commands.

Shortcut Command Section

Command
The Shortcut Command that you want to execute.    The following commands are available:

Create Folder - Creates a new folder as specified in Folder.    If the folder already exists, it will not 
be modified by this command in any way.

Remove Folder - Deletes the named folder and all shortcuts that it contains.    If the folder does 
not exist, nothing will happen by using this command.

Create shortcut in folder - Creates a shortcut with the name specified in Description.    The 
shortcut will be added to the folder specified in Folder.    If the folder does not exist, it will be created first.

Remove shortcut from folder - Removes the shortcut with the name specified in Description from 
the folder specified in Folder.

Shortcut Folder Section

Folder
The name of the folder that you want to create, delete, add a shortcut to or remove a shortcut from.    See 
Folder Naming Rules for important folder naming information.

Shortcut Details Section

All of the fields in Shortcut Details are used by the Add shortcut to folder command.    The Remove 
shortcut from folder command only uses the Description field.

Description
The description that will appear with the shortcut.

Note:    Under Windows 3.1 or Windows NT 3.51 there is a limit of 40 characters for an icon description.    
Under Windows 95/NT 4.0, you can enter up to 255 characters for a shotcut’s description.

Points to
The name of the file that this shortcut points to.

Arguments
Command line arguments that you want to pass to the file specified in Points to above.

Working dir
The path of the working directory of the file.

Icon path
The full path to the file that contains the icon that you would like to represent this shortcut.    In most 
cases, this will be exactly the same as the information in Points to, however you are free to specify an 
alternate icon file.    The file must contain a valid Windows .ICO file for this to work.



Icon index
The index of the icon in the file specified as Icon path.    If there is only one icon in the file, or if you want 
to use the first icon found in the file, enter "0" here.

Example 1 - Creating a folder
Example 2 - Creating a shortcut for a file on a CD-ROM
Example 3 - Deleting a folder
Example 4 - Deleting a shortcut from a folder
Example 5 - Creating a folder and shortcut on the Windows 95 Desktop



Shortcut Editor...
Selecting Shortcut Editor from the Project menu will open the Shortcut Editor screen.

IMPORTANT NOTE:    Shortcuts are the Explorer Interface (Windows 95, Windows NT 4.0) equivalent to 
Program Manager icons (Windows 3.1, Windows NT 3.51).    If you are building installs for Windows 3.1 or
Windows NT 3.51, all references to shortcuts can be applied to program icons and all references to 
folders can be applied to program groups unless otherwise noted. 

A Shortcut Command allows you to create extra shortcuts and folders in addition to the ones 
automatically created by using the Properties command.    The Shortcut Editor will be most useful in 
situations where you want to create a shortcut for a file that was not installed by Setup Factory, or to 
create a duplicate shortcut for a file that is being installed by Setup Factory.    This feature is often used to 
create shortcuts to files on a CD-ROM when producing CD-ROM based installations.

Another possible use of the Shortcut Editor is to place a folder and/or shortcut on the Windows 95 and 
Windows NT 4.0 Desktop.    Note, however, that shortcut commands to the desktop will only be executed 
under Windows 95 and Windows NT 4.0 and will have no effect under Windows 3.1, etc.

The Shortcut Editor screen consists primarily of a large text box.    This text box contains a list of all 
Shortcut Commands that will be made during the installation, in the order that they will be made.    Each 
modification is on its own line, therefore each line in this list represents one Shortcut Command.    The 
commands on this screen will be executed in top - down order.

Shortcut Editor ScreenYou can create and order your Shortcut Commands using the buttons on the right 
side of the screen:

Add
Opens the Shortcut Command screen which allows you to create a Shortcut Command.    The command 
that is created will be added to the end of the list.

Insert
Opens the Shortcut Command screen which allows you to create a Shortcut Command.    This new 
command will be inserted directly above the command that was highlighted before clicking the Insert 
button.

Edit
Opens the Shortcut Command screen and allows you to edit the information in the currently selected 
Shortcut Command.

Remove
Removes the currently selected Shortcut Command from the list.

Up
Moves the currently selected Shortcut Command up one position in the list.

Down
Moves the currently selected Shortcut Command one position down in the list.



Starting the Project Wizard
Before starting the Project Wizard you should make sure that the files you are creating a setup for are 
arranged on your system in a proper directory hierarchy.    For example, our hypothetical Internet suite 
starts in the \NETSTUFF directory.    This is the top level of our hierarchy.    Beneath this directory are 
three subdirectories as follows: \NETSTUFF\BROWSER, \NETSTUFF\DIALER and \NETSTUFF\
EMAILER.    Our files reside in these directories and we want to maintain this structure when our user 
installs the software on their system.    That is, the \NETSTUFF directory name can be anything the user 
wants, however the subdirectories of \NETSTUFF should be created verbatim.    For more information 
about preparing your directory structure see Preparing the Directory Structure.    To start the Project 
Wizard select Help | Project Wizard from Setup Factory's main menu or choose the Project Wizard option 
from the Welcome screen if you are just starting Setup Factory now.

After starting the Project Wizard, you will be presented with a screen full of information that describes 
what the Project Wizard is going to do.    Click on the Next button to move to the first step.

Next Step



System Minimums...
The System Minimums Screen is used to specify the minimum system configuration that your users must 
have in order to use your software.    If any requirement is not met, the program will inform the user of that
fact and can even abort the installation if you desire.

General Section

Operating system
The minimum operating system platform that your software requires.    The following choices are provided:

N/A - Not applicable.    If selected, the installation program will not check for the end user's 
operations system.

Windows 3.1 - Microsoft Windows version 3.1
Win32s 1.3 - Microsoft Windows version 3.1 with Win32s version 1.3 running.
Windows 95 - Microsoft Windows 95
Windows NT 3.51 - Microsoft Windows NT version 3.51
Windows NT 4.0 - Microsoft Windows NT version 4.0

System RAM (MB)
The minimum required system RAM for your software. 

Mouse
If checked, the installation will check the user's system for the presence of a mouse.

Sound card
If checked, the installation will check the user's system for the presence of a sound card.

Graphics Section

Screen size
The minimum required screen size for your software.    Your choices are N/A (not applicable), 640x480, 
800x600, 1024x768 and 1280x1024.    If N/A is selected, the installation will not check for screen size.

Color depth
The minimum color depth that your software requires.    Your choices are N/A (not applicable), 2 Colors, 
16 Colors, 256 Colors, 32,768 Colors, 65,536 Colors and 16.7M Colors.    If N/A is selected, the 
installation will not check for color depth.

What to do if a minimum requirement is not met Section

Notify the user and abort the installation
If selected, the user will be informed that they did not meet all system requirements and the installation 
will abort.

Warn the user and continue the installation
If selected, the user will be informed that they did not meet all system requirements but the installation will
continue.

Note: Be prudent in the use of the Notify the user and abort the installation option.    If you have the 
installation abort, the user may become frustrated.    Usually the warning that a problem exists is 
sufficient. 





Step Five - Building the Disk Set
The final step is to build the disk set.    We do this by selecting Build | Create Master Disk Set from the 
main menu.    This will start the disk building process.    When we get to the Setup Factory Disk Builder 
screen, we simply click the Output button to accept the defaults and continue to build the disk set to 
floppies.    After the build is complete, you can try out your disk set.    Put the first disk in your drive, and 
run the Setup.exe!    Groovy stuff.

At this point you should save your project file by selecting File | Save As... from the main menu. In this 
tutorial we have saved the project as NETSTUFF.SFP.    This is as far as many of you will need to go in 
the tutorial.    After you have completed the above steps, you can experiment with some some of the other
features of Setup Factory.    Try displaying other screens from the Screens menu and see what you get.    
Fool around with the Wallpaper command.    Try outputting your disk set to your hard drive rather than 
floppies.    Have a good time - you deserve it.    Setup Factory is fun!

Next Step



Step Four - Changing the Shortcut Descriptions
Although we could go ahead and build our disk set by selecting Build | Create Master Disk Set, we will 
first customize one option.    By default Setup Factory has selected all of our .exe and .hlp files to have 
shortcut icons created for them.    The only problem is that Setup Factory can't read your mind (yet!).    The
default description that it gives to your shortcut icons is rather "boring".      It simply uses the filename for 
the description.    For example, the file BROWSER.EXE's shortcut description will be called 
"BROWSER.EXE" by default.    Seeing as how we are creative folk, we want to change this to something 
a little more descriptive.

To do this, we use the following steps:

1. Select Project | Preferences from the main menu to open the Preferences screen.
2. Check the Sort filenames by extension checkbox and click OK.
3. Click on the Name heading on Setup Factory's Main Screen to sort the files by their extensions.    This 
will make it a bit easier to find all of your .EXE files as they will all be grouped together.
4. Click on the EMAILER.EXE file (or any other .EXE file that is in your project).
5. Select Project | File Properties to open the File Properties screen for the file.
6. Select the Shortcut page.
7. Change the Description field to "NetStuff Email".
8. Repeat steps 1-7 for each .exe and .hlp file in the project.

Next Step



Step One - General Information
The first Project Wizard screen after the introduction screen is used to collect general information about 
your software.    Fill in the fields with the information you see below.

What is your program name or title? - "NetStuff Internet Suite"
What is your copyright message? - "Copyright © 1996 Our Company"

Click on the Next button when you are ready to continue to the next step.

Next Step



Step Three - Default Directory and Folder
On this screen we enter the name of the suggested installation directory and shortcut folder (Program 
Group for non Windows 95 users).    Since we are not locking the drive, directory or folder, the user will be
able to enter something other than the suggested defaults during the installation.

What is the suggested installation directory? - "C:\NETSTUFF"
Lock drive - Unchecked
Lock directory - Unchecked
What is the suggested shortcut / icon folder? - NetStuff Internet Utilities
Lock shortcut / icon folder - Unchecked

After you click on the Next button you will be presented with the last Project Wizard screen.    It says that 
there is now enough information to generate your project.    Click on the Finish button when you are ready 
to generate the custom project.    There will be a short delay while files are added to the project and other 
chores are performed.    After a few seconds you will be staring at Setup Factory's main screen with your 
new project all ready to go!

Next Step



Step Two - File Location
On this screen we enter the home directory of our software.    If you are not sure where the directory is, 
use the Browse button to navigate the directories on your hard drive.    As was described earlier, our 
Internet suite is stored in \NETSTUFF and has subdirectories below it.

What directory are your files located in? - "C:\NETSTUFF"
Include files in subdirectories - Checked

Since you are following along and most likely do not have a C:\NETSTUFF directory, you will have to 
enter a different directory on this screen.    Pick a directory that has a few files in it, say between 1 and 4 
MB worth.    You don't want to get too wild on your first setup!    Save something for later...    Click the Next 
button to continue to the next screen.

Next Step



Step Four - Building the Disk Set
The final step is to build the disk set.    We do this by selecting Build | Create Master Disk Set from the 
main menu.    This will start the disk building process.    When we get to the Setup Factory Disk Builder 
screen, we simply click the Output button to accept the defaults and continue to build the disk set to 
floppies.

Congratulations!    You are now an apprentice expert in using Setup Factory.    To move up to a full expert, 
you will need to try out some of the even more advanced features of Setup Factory.    Don't be scared!    
You already know that the hardest thing about using Setup Factory is getting the shrink wrap off the 
package.    Good luck!



Step One - Creating Packages
The first step in making a selective install is to figure out which files must always be installed and then 
create packages for the optional files.    For our imaginary Internet suite we know that, come hell or high 
water, we always want to have the files in the NETSTUFF directory installed.    To do this we must make 
sure that all of these files belong to the special package called "None".    Files that belong to the special 
package "None" are always installed.    "None" is the default package for all files that are added to your 
project, so you will notice that all of your files are already part of the "None" package.

We want each of the other three programs in their own packages: NetStuff Dialer, NetStuff Browser and 
NetStuff Emailer.    Furthermore we must decide which install type each package belongs to.    For 
example, all of our packages should belong to the Complete Installation, but we decide that the Minimum 
Installation should not include the Emailer.    And, just for fun, we will make it so that the Typical 
Installation does not include the Dialer.

We create the packages using the following steps:

1. Select Project | Package Manager from the main menu to open the Package Manager screen.
2. Click on the New button to create a new package.    The Package Information screen will appear.
3. Name the first package "NetStuff Email" by typing it into the Package name field.
4. Enter "The NetStuff Internet email program." as the Package description field.
5. Uncheck the Minimum installation field and click OK.
6. Click on the New button.
7. Name the package "NetStuff WWW Browser" in the Package name field.
8. Enter "The NetStuff Internet WWW browser." as the Package description field.
9. Click OK.
10    Click on the New button.
11. Name the package "NetStuff Dialer" in the Package name field.
12. Enter "The NetStuff Internet dialer." as the Package description field.
13. Uncheck the Typical installation field and click OK.

Next Step



Step Three - Customizing the Select Install Type 
Screen
The final step in creating our selective install is to customize the Select Install Type screen that will 
appear during installation.    To do this, use the following steps:

1.    Open the Select Install Type screen by choosing Screens | Select Install Type from the main menu.
2.    Enter the following values for the fields on this screen:

Display this screen - Checked
Title Box - Installation Type
Field 1 - Complete
Field 2 - Installs the entire NetStuff suite.    This includes the Dialer, Browser, and Emailer and all 

support files.
Field 3 - Typical
Field 4 - Installs the NetStuff Browser and Emailer and all support files.
Field 5 - Minimum
Field 6 - Installs the NetStuff Browser and Dialer and all support files.
Field 7 - Custom
Field 8 - Allows you to select components to install, or add new ones to your existing installation.

3.    Click OK to close the Select Install Type screen

Next Step



Step Two - Adding Files to the Packages
The next step is to add the files to each package.    To do this we perform the following steps:

1. Close the Package Manager by clicking the OK button.
2. On the Main Screen, click on the Source header to sort the files according to their source.    This makes
it easier to see which files are in each directory by grouping them together.
3. Highlight all of the files from the BROWSER directory by clicking on the topmost one, holding down the 
shift key, and then clicking on the lowest one in the list.
4. Select Project | File Properties to open the File Properties (Multiple Files Selected) screen.
5. Select "NetStuff WWW Browser" as the Member of this package field and click OK.
6. Repeat steps 3-5 for the Dialer and Emailer files.

At this point, our files are all in their appropriate packages.    If you want a more graphical representation 
of the packages and files, open the Package Manager and check the Display filenames box.    You can 
now expand each package to view its contents.    All files that are always installed are listed under 
Unpackaged Files.

Next Step



Testing Your Installation
Always, always, always test your installation thoroughly before distributing your software.    This point 
cannot be stressed enough.    You do not want to find out from your customer that you forgot to include a 
file or have made some other easily fixed mistake.    Try your installation on as many different computers 
with as many different operating systems, hardware components, system resources (HD space free, RAM
free, etc.), networks and software packages installed as possible.    Although we have thoroughly tested 
the Setup.exe created by Setup Factory, the onus is on you to ensure that you have used Setup Factory 
properly and have created a working installation for your particular software.

Not only should you test the installation, but also give your software a good test run on each of the trial 
systems to ensure that it is running properly.    A poorly thought out or tested installation (or any 
application for that matter) can lead to wasted time and resources and much frustration and 
embarrassment by both you and your users.



The Main Screen
Setup Factory is designed to get you right into the action!    This is quickly apparent from a glance at the 
Main Screen.    The Main Screen is not just for show - it is an integral part of the Setup Factory 
Development Environment.    The Main Screen contains the following features:

Main Menu
Toolbar
Project Window



Timing Page
Prompt for Disk
This feature is useful if you want to execute a program off of a floppy disk but the program does not reside
on the current disk.

Ask for disk before trying to execute program
If checked, the installation will ask the user to insert the disk with the title specified in Disk title below.

Disk title
The title of the disk that the installation will ask for.    This title will be used in the prompt, such as "Please 
insert the following disk: Disk title".

Note:    The Prompt for Disk options are only needed in a very limited number of cases.    Asking for a disk
should only be necessary if the file that you want to execute has a) not been installed and b) is not 
located on the current disk.

When do you want to execute the program?
You have control over when the program will be executed during the setup process.    Choose from the 
following options:

Before first screen - Execute before the first "wizard" appears.    Note that some inline variables, such as 
%AppDir% are not defined at this point.

Before installing - Execute after the first "wizard" has been completed, but before any files are installed.

After installing - Execute after the files are installed, but before the second "wizard" appears.

On termination - Execute after the second "wizard" is completed, right before the setup program ends.



Tips & Tricks
The following Tips & Ticks will help you get the most out of Setup Factory.

Inserting Special Symbols
To insert a Copyright © symbol in your text, hold down the Alt key and type 0169 on your numeric keypad. 
To insert a registered trademark symbol ® type Alt 0174.

Registering a Path in Windows 95 / NT
Since there is no AUTOEXEC.BAT file used in Windows 95, you can register a program's path on a per-
application basis.    The way to do this is to add the default and path values to the appropriate key using 
the Registry Editor:

Key:    HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\AppPaths\Program 
Name.EXE

Value:    Default = Drive:\Program Files\Program Path\Program Name.EXE
                        Path = Drive:\Program Files\Program Path; Drive:\Program Files\Common Files

Creating an Auto-run File for a Windows 95 CD-ROM
To add the Windows 95 supported Auto-run feature to your CD-ROM you must create a file called 
"AUTORUN.INF" in the CD-ROM's root directory.    The AUTORUN.INF file should look like this:

[AutoRun]
OPEN=My Program Name.Exe

Copying, Cutting and Pasting
You can use Ctrl-C to copy to the Windows clipboard, Ctrl-X to cut to the Windows clipboard and Ctrl-V to 
paste from the Windows clipboard in many of Setup Factory's screens.

Creating Custom Wizard Images
If you wish to be creative and design your own Wizard style images, here are a few hints:

Make your Wizard images 135 pixels wide X 223 pixels high.
The RGB value for the gray color used on all dialogs is RGB 192, 192, 192.
Use as many colors as possible from the standard Windows palette.    Using the Windows' Paint 

(or Paintbrush) program will restrict you to the standard palette.

Reducing the Size of Your Setup 
Setup Factory requires a relatively small amount of overhead, only about 150K.        The required minimum
overhead increases as you add files, text and images to your project.    If you do need to reduce the size 
of your installation, try the following:

Do not include an uninstall program.
Since Setup Factory will not duplicate images used in the Wizard screens, use the same image 

for all of your screens (the image must have the same filename and be from the same directory).
Try using Medium or Low compression on files that are smaller than 4K.    Use Text as the 

Optimize method for all text files.
Remove all text from unused Screens.
Don't use a bitmap in the background.    Try a gradient or pattern - these take no extra space.
Use Arial or Times New Roman for the header and footer fonts in your setup.

Installing a Font



The easiest way to install a TrueType font onto the user's system is to check the Register *.ttf as font 
option on the Adding Files page of the Preferences screen and then add your font files to your project.    
Setup Factory will then do all of the work for you.    This option is checked under Preferences by default.

If you have already added a .TTF file to your project and want to register it during installation, check the 
Register this file as a TrueType font option on the Advanced Page of the File Properties screen for 
the .TTF file.    To verify that the file is a proper TrueType file,    click on the Auto-Name button and see if 
Setup Factory can detect its name.    Make sure the file is being install to %FontDir%.



Toolbar
The Setup Factory toolbar will help you quickly and efficiently access some of the most common 
commands used in Setup Factory.    The toolbar is "dockable" which means that you can click and hold 
the mouse on a non-button part of the toolbar and drag it to a different location on the screen.    It can be 
docked on the top, bottom, right or left of the screen or you can leave it "floating" over Setup Factory's 
Main Screen.



Opens the Add Files to Project screen which allows you to add one or more files to your project.    It 
functions the same as choosing Project | Add Files to Project.



Builds the installation for the currently open Setup Factory project.    It functions exactly the same as 
choosing Build | Create Master Disk Set.



Displays the properties for the currently selected file(s).    It functions the same as choosing Project | File 
Properties.



Opens the Setup Factory help file contents.    It functions exactly the same as choosing Help | Contents.



Opens a new Setup Factory project.    It functions exactly the same as choosing File | New.



Opens a previously saved Setup Factory project.    It functions exactly the same as choosing File | Open.



Removes the currently highlighted files from the project.    It functions the same as choosing Project | 
Remove File from Project.



Saves the currently open Setup Factory project.    It functions exactly the same as choosing File | Save.



Starts the Setup Factory Project Wizard.    This is a great way to get all of your projects off to a great start!



Tutorial
Introduction
This section will walk you through the creation of your first install using Setup Factory.    Setup Factory 
was designed with both ease-of-use and flexibility in mind.    Our goal is to get you, the setup author, on 
your way with a hassle-free installation in minutes.    It is much easier to actually use Setup Factory than it
is to describe.    You will quickly find that once you grasp a few important concepts, the entire process is 
quite intuitive.

There are two parts to this tutorial.    In Part One we will create a quick and simple install.    Don't be 
fooled!    The install we will create is packed full of features and power.    Simple only describes how easy 
it is to create using Setup Factory!    For most people this is all the functionality they will ever need in their 
setup program.    For those people who need even more flexibility, we will build upon this installation in 
Part Two and show you how to create a selective install using the "packages" feature.

Overview
For the sake of this tutorial, we are going to pretend that we have just created a new suite of Internet 
software (just what the world needs!).    Our software includes a Dialer program that is used to connect 
our users to the Internet, a World Wide Web Browser and an Email program.

We will assume that the software is located in a directory called NETSTUFF with three subdirectories 
called BROWSER, DIALER and EMAILER.

Proceed with Tutorial
Choose one of the tutorial topics below to start with or select Next Step to proceed with the tutorial in 
sequential order (suggested):

Part One - Simple Installation
Starting the Project Wizard
Step One - General Information
Step Two - File Location
Step Three - Default Directory and Folder
Step Four - Changing the Shortcut Descriptions
Step Five - Building the Disk Set

Part Two - Selective Installation
Step One - Creating Packages
Step Two - Adding Files to the Packages
Step Three - Customizing the Select Install Type Screen
Step Four - Building the Disk Set

Next Step



What Exactly Does the Uninstall Do?
The user runs the uninstall program by either clicking on the uninstall icon in their shortcut folder, or by 
using the Add/Remove Program feature of the Windows 95 control panel. The uninstall will then perform 
the following actions:

1.    The user will be presented with the introduction message.    This message lets the user know what is 
going to happen, and gives them the opportunity to abort.
2.    Executes the program you specified in the Execute before uninstall field.    The uninstall will wait until 
this program ends before continuing.
3.    Removes all files that were installed to the user's system during installation, except for those being 
installed to %WinDir%, %SysDir%, and %FontDir%.    If the Remove all files installed to %WinDir% and 
%SysDir% option is selected, then those files will be deleted as well.    Since Setup Factory automatically 
registers the usage count on .DLL and .OCX files that are installed to %WinDir% or %SysDir%, these files
will only be removed if the usage count drops to zero (The usage count is a registry entry for the file that 
keeps track of how many applications are using it).
4.    Removes all shortcuts that were created during the installation.    This includes both the shortcuts that 
were created according to the File Properties, and those created using the Shortcut Editor.    After 
removing the shortcuts, the uninstall will check to see if the shortcut folder is empty.    If it is empty, then it 
will be removed.
5.    Removes additions made by the INI File Editor.
6.    Removes files listed in the [Files] section of the IRUNIN.INI file.    The IRUNIN.INI file is created in 
%AppDir% during the setup and contains information that is required by the uninstall program.    If you 
would like the uninstall to remove more files than were installed (such as data files created by your 
application), you can add them to this file.    Using the INI File Editor, you simply add lines to the file 
%AppDir%\IRUNIN.INI.    The section you want to modify is Files, and each line must follow the form FileX
= FileName.    Where X represents the file number, starting at 1 and moving sequentially upwards.    The 
FileName must be the full path to a file on the user's system.    For example, your IRUNIN.INI    file might 
look something like this:

[Files]
File1 = C:\MYAPP\DATA1.DAT
File2 = C:\MYAPP\DATA2.DAT
...
File10 = C:\MYAPP\DATA10.DAT

7.    Performs some clean up, and then displays the exit message.    This message lets the user know that 
the uninstall is finished.



Uninstall - Exit Msg Page
The Exit Msg page contains the text that will be displayed after the uninstall is finished.

Message Title
The text that will appear as the title of the exit screen window.

Message Text
The text that will be displayed on the exit screen of the uninstall.    Here you can thank the user for 
choosing your software package and let them know that if they want to use your software again, they will 
need to re-install it.



Uninstall - General Page
The General page is used to enable and configure the uninstall procedure.

Uninstall Options Section

Create an uninstall program
If checked, Setup Factory will create an uninstall program during the installation.

Registry key
A short, unique name that will be used by Windows 95 to identify the uninstall for your application.    The 
name must be 20 characters or less and should not contain any spaces or punctuation.    A shorthand 
version of your application name is a good choice.

Add/Remove description
The description that will appear in the Windows 95 Control Panel under Add/Remove Programs.    This will
usually be the name of your application.

Shortcut/icon description
The description that will accompany the uninstall shortcut.    This shortcut will be created along with the 
other shortcuts in %AppFolder%.    You will normally enter something like Remove MyApp, where MyApp 
is your application name.    If this field is left blank then a shortcut will not be created.

Wallpaper header text
The text that will appear on the background screen of the uninstall.    The text will be drawn in white, with 
a shadow, using a 48 point Arial Bold Italic font.    The uninstall uses the same wallpaper pattern as the 
setup (i.e. the options specified on the Pattern page of the Wallpaper screen).

Advanced Section

Execute before uninstall
The full path and file name of a program to execute at the start of the uninstall process.    This program 
will be run after the user confirms that they want to start the uninstall, but before any files are removed.    
Leave this field blank if you do not need to execute a program.

Remove all files installed to %WinDir% and %SysDir%
If checked, all files that were installed to %WinDir% and %SysDir% during installation will be removed by 
the uninstall program.    By default, Setup Factory does not remove these files because they may be 
shared by other programs.    In accordance with Microsoft guidelines, any file with the extension .DLL 
or .OCX is removed only if its usage count drops to zero.



Uninstall - Intro Msg Page
The Intro Msg page contains the text that will be displayed at the beginning of the uninstall.    You will want
to display a message that lets the user know that files will be erased and shortcuts removed.

Message Title
The text that will appear as the title of the introduction screen window during the uninstall.

Message Text
The text that will be displayed on the introduction screen of the uninstall.    This should welcome the user 
to the uninstall and explain what is going to happen if they choose the Uninstall button.



Uninstall...
Setup Factory can make quick work of creating an uninstall program for your software.    An uninstall 
program makes it easy for your users to remove the software that was installed on their system.    In fact, 
one of the Windows 95 logo requirements is to include an uninstall procedure - and Setup Factory can do 
it with the click of a button!

What Exactly Does the Uninstall Do?
General Page
Intro Msg Page
Exit Msg Page



Verify Password...
This screen is used to prompt the user for a password, serial number, secret code, or whatever you want 
to verify.    The password that the user must enter is specified in the field labeled Password to check for.    
The installation will not proceed unless the correct password is entered.    This feature can be an excellent
form of copy protection for your software.    See General Screen Design Layout for more details about the 
fields on this screen.



View Menu
The View menu contains commands to customize the Main Screen of Setup Factory.

Toolbar
If there is a check mark beside this option, the toolbar will be displayed on the screen.    Note that the 
toolbar is "dockable" which means you can drag it around the screen and drop it anywhere that is 
convenient.    If this option is not checked, the toolbar will not appear on the screen.

Status Bar
If checked, the status bar will appear at the bottom of the screen.    The status bar provides you with 
useful project information and hints about menu commands.    If this option is not checked, the status bar 
will not appear on the screen.

Large Icons
If checked, the files in your project will appear in the large icon format. 

Small Icons
If checked, the files in your project will appear in the small icon format. 

List
If checked, the files in your project will appear in the list icon format. 

Details
If checked, the files in your project will appear in the detailed report format.



Wallpaper - Bitmap
Bitmap file
The full path of a bitmap file to display on your wallpaper.    If this field is left blank, a bitmap image will not
be used.    A Select button has been included to help you find the bitmap file that you want.    If you wish to
clear or "unload" the current bitmap, click the Clear button.

Position
The position on the screen where the bitmap will appear.    The choices are Stretch, Tile, Top Left, Top 
Center, Top Right, Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom 
Right.    If you select Stretch, the bitmap will be stretched to fill the entire background.    If you select Tile, 
the bitmap will be tiled across the background screen at its original size.    Otherwise, the image will 
appear in the specified position at its original size.

Bitmap file preview
A preview of the bitmap that you have selected.



Wallpaper - Footer Text
The Footer Text is the text that will appear at the bottom of the wallpaper screen.    All options for Footer 
Text are the same as those described in Header Line 1 except they will be applied to the footer text.



Wallpaper - Header Text
The Header Text is the text that will appear along the top of the wallpaper screen.    You can use the 
Header Text to display your company name, product name or any other text that you wish.

Header Line 1 Section

In the Header Line 1 section you can customize the text for the first (top)    line of header text that will 
appear on the installation background:

Text
The text that you want to appear.

Position
The alignment of the text.    The options are Left, Right or Center.

Shadow
If you select this option then the text will be displayed using a 3-D shadow effect.    It looks pretty cool!

Select Font
Pressing the Select Font button will open a Font dialog box.    Here you can customize the font name, 
style, size, effects and color.    We recommend that you use a standard Windows font such as Arial, Times
New Roman or Courier New.    If you do not change this font, you will find that the default font face (Arial) 
and size will look quite good on all systems.

Font File
The full path of a custom TrueType font file that you want to use to display the Text in.    This font file must 
correspond with the font you have selected using Select Font.    It is only necessary to specify a file name 
in this field if you are not using a standard Windows font such as Courier New, Arial, or Times New 
Roman.    The font specified here will not be permanently installed on the user's system but will only be 
used during the installation process.

Please note that most of the fonts on your system are copyrighted by their respective manufacturers and 
you may require special licensing terms from the font manufacturer in order to distribute their font file.    It 
is advisable to check with the manufacturer of the font to find out if you may distribute their font in this 
manner.    You can make your life a bit easier by simply using a standard font that all of your users will 
have, such as Arial or Times New Roman.

Note:    You only need to include a custom Font File once.    For example, if you are using a font in both 
Header Line 1 and Header Line 2 that requires the custom font file MYFONT.TTF, you only need to 
include it for one of those sections, not both.

Browse
The Browse button is used in conjunction with the Font File field described above.    Pressing the button 
will let you browse for a .ttf file and will automatically enter the file name in the Font File field.

Sample
An example of what the text will look like using the font that you have specified.    The sample will not be 
indicative of the font size that you have chosen but rather will always be sized to fit the sample window.    
All other font properties will be applied to the sample.

Header Line 2 Section



This section lets you customize the second line of header text.    This text will appear underneath the text 
your specified in Header Line 1.    All options for Header Line 2 are the same as those described in 
Header Line 1 except they will be applied to the second line of header text.



Wallpaper - Pattern
Style
The style field is used to specify the type of pattern that is displayed in the background of your installation.
Your choices are: Solid Background, Gradient, Hatch, Grid, Cross Hatch, Back Hatch, Horizontal Stripes 
and Vertical Stripes.

Solid Background - A solid fill of the background color.
Gradient - A vertical color wash.    The color will gradually fade from the foreground to background

color.
Hatch - Parallel lines that slant from the top right of the screen down towards the bottom left.
Grid - Parallel lines that run horizontal and vertical forming a cross type effect.
Cross Hatch - Parallel lines that run diagonal down left and diagonal down right forming an X type

cross effect.
Back Hatch - Parallel lines that slant from the top left of the screen down towards the bottom 

right.
Horizontal Stripes - Parallel horizontal lines.
Vertical Stripes - Parallel vertical lines.

Foreground
The color of the foreground.    If you are using a gradient, this is the color that will appear at the top of the 
screen for the fade.    Otherwise, this is the color that will be used to draw the pattern.    Think of this as 
your pen color.

Background
The color that the background will be.    If you are using a gradient, this is the color that will appear at the 
bottom of the screen for the fade.    Think of this as your paper color when using any other pattern.

Pattern preview
A preview of what your background pattern will look like using the options that you have chosen on this 
tab.



Wallpaper...
The Wallpaper screen will always appear in your installation.    It provides the backdrop for the entire 
installation process.    You can mix and match options giving you a virtually unlimited number of 
appearances for your installation.

Pattern
Bitmap
Header Text
Footer Text



Welcome Message...
The Welcome Message screen will normally be the first screen that the user sees when they run your 
installation.    This is a great place to put a "Welcome" message and/or instructions about the installation 
or your software.    The fields on this screen follow the outline in General Screen Design Layout.



Windows 95 Considerations
If you are creating your installation specifically for Windows 95, Microsoft has published guidelines that 
they recommend you follow both when writing your software program and while creating your installation.  
Many of the guidelines are very specific to Windows 95, but the philosophy behind the suggestions can 
be applied to other operating systems.    One benefit of following these guidelines is that they will help you
standardize the organization and management of your program files, making software installation, 
removal and updating easier on you and your users.

Note:    The following information is being provided to you without going into the full details and 
considerations that are necessary to implement all of these suggestions.    It is recommended that you 
consult a good Windows 95 programming text if you wish to follow this advice, as many of the 
recommendations relate to the way your software is written and only secondly to how it is installed.    
Setup Factory can handle all of the installation suggestions that follow, but it is up to you to make sure 
your software obeys the rules!

Guideline 1
Your install program should offer the following installation options:

Complete Setup - Installs all of the files and options.

Typical Setup - Installs the application with the most common settings and files.

Minimum Setup - Copies the minimum number of files necessary to operate your application.    
This option is useful for users with laptops or systems with minimal amounts of free hard drive space.

Custom Setup - Allows the user to control what files or groups of files are installed.    This option is
typically used by the advanced user who knows what files they do or do not need.

To implement these different types of installation options, see "Packages".

Guideline 2
Your executable(s) should be installed to a subdirectory of "\Program Files" and should provide a long 
filename as the default.    It is therefore recommended that you install your executable(s) to "\Program 
Files\Your Long Directory Name".

Guideline 3
Any other executable or data files such as DLLs or Help files should be installed to a subdirectory of "\
Program Files\Your Long Directory Name" called "System".    It is therefore recommended that you install 
all non-executable program files to "\Program Files\Your Long Directory Name\System".

Guideline 4
Any system-wide shared files should be installed to the Windows "\SYSTEM" directory.    A system-wide 
shared file is a file that many different applications from different vendors use.    An example of this type of
file is Visual Basic's VBRUN300.DLL.

Guideline 5
All non-system-wide shared files should be installed to "\Program Files\Common Files\System".

Guideline 6
Since Windows 95 does not use the CONFIG.SYS and AUTOEXEC.BAT files, you should not attempt to 
make any changes to these files whatsoever.    If you need to set the PATH for an application, it can be 
done through the Registry Editor.    See Tips & Tricks for more information about how to register a path 
under Windows 95 / NT.



Guideline 7
Do not use the WIN.INI file.    Instead, set all per-application settings in the Registry.

Guideline 8
Name your installation "Setup.exe".




